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PREFACE

et Station from Electrical Geodesics, Inc. (EGI) is a complete software package 
for working with electroencephalography (EEG) and event-related potential 

(ERP) data. With Net Station, you can:

• acquire EEG, in conjunction with EGI’s Net Amps and Neurotravel amplifiers, 
and dense-array Geodesic Sensor Nets

• perform various operations on your data, primarily for basic ERP derivation 
and analysis 

• view and navigate EEG and ERP data

Note: Net Station does not support Unicode string.

This publication, the Net Station Viewer and Waveform Tools Tutorial, instructs you 
in the use of Net Station Viewer and Waveform Tools by guiding you through the 
analysis of a sample data set. It is not intended to be a comprehensive guide to these 
components, but it is a good place to start when learning about the software. 

The Net Station Acquisition is the component of Net Station for acquiring EEG, in 
conjunction with the dense-array Geodesic Sensor Nets. The Net Station Acquisition 
Technical Manual describes Acquisition features and functions.

The Net Station Viewer is the component of Net Station for viewing and navigating 
EEG and ERP data. The Net Station Viewer Technical Manual describes Viewer 
features and functions. 

The Net Station Waveform Tools is the component of Net Station for performing 
various operations on EEG data, primarily for basic ERP derivation and analysis. The 
Net Station Waveform Tools Technical Manual describes Waveform Tools features 
and functions. 

N
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The Net Station File Formats Technical Manual documents the objects contained in a 
native Net Station file, the formats of the export files, and other files associated with 
Net Station.

The Geodesic Sensor Net is EGI’s patented device for acquiring electrical signals from 
the human scalp. The Geodesic Sensor Net Technical Manual describes all GSN 
features and functions.

GES hardware is all the system hardware except for the GSN. GES hardware supports 
the acquisition and processing of EEG data and includes an amplifier, a data-
acquisition computer, a monitor, and, in most cases, a cart or travel case. The 
GES Hardware Technical Manual provides comprehensive descriptions of all 
GES hardware components and features.

(PDF versions of these publications and other EGI documentation are at www.egi.com/
documentation.html.)

These publications contain a good deal of background information on the EEG and 
ERP field. However, they are not intended to represent a complete primer in this field. 
To get the most out of these books, you should have some background in EEG and 
ERP methods. 

These manuals assume you are familiar with the Macintosh computer, the platform 
for Net Station software. 

About This Tutorial

The purpose of this tutorial is to instruct you in the use of Net Station Viewer and 
Waveform Tools. These are the components of Net Station for working with existing 
EEG and ERP data, as opposed to those components for acquiring EEG data. 

Net Station Viewer consists of the feature set you use for viewing and navigating EEG 
and ERP data. Net Station Waveform Tools consists of the tools you use for 
performing operations on your data, primarily for ERP derivation. 

Note: This tutorial does not cover some of the advanced Waveform Tools and Viewer 
options, such as Markup from File, Ocular Artifact Removal, Short Epoch Filtering, 
t-test, Wavelet, Spectral Display, and video EEG. These tools represent operations that are 
not part of the core data-analysis path used to derive ERPs.
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This tutorial is not intended to be a comprehensive guide to these components. 
Instead, the aim is to familiarize you with them by guiding you through the analysis 
of a sample data set. 

Features
This manual is supplied as a PDF file and in printed form. The hard-copy version has 
been printed from the PDF so the content of both will match. The printed manual 
contains mostly grayscale images; the PDF contains color and grayscale images. 

Tutorial Organization
This tutorial features a table of contents, list of figures, list of tables, and index, which 
in the PDF are all hyperlinked to the topics they reference in the publication.

The tutorial consists of four sections:

• Introduction
• Exploring Unprocessed Continuous Data
• Deriving ERPs
• Exploring ERPs

Each section contains chapters that elaborate on the section topic.

• Section I, “Introduction,” describes the tutorial, introduces the tutorial data set, 
and discusses some important terms and concepts.

• Section II, “Exploring Unprocessed Continuous Data,” describes how to use 
Net Station Viewer for exploring your data before the ERP derivation process. 

• Section III, “Deriving ERPs,” describes how to use Net Station Waveform Tools 
for the operations involved in deriving ERPs. It also shows you how to use 
Net Station Viewer to examine the results of each operation. 

• Section IV, “Exploring ERPs,” describes how to use Net Station Viewer and 
Waveform Tools for exploring ERPs once they have been derived. 
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Conventions and Typography
In this tutorial:

• A minimal amount of special fonts are used—italics for definitions or newly 
introduced terms, boldface italics for important concepts, and boldface for 
command paths (e.g., File > Save).

Additional Information
Two different methods are used to convey additional information: notes and cautions.

Note: This indicates information that is helpful in understanding Net Station operations.

Caution!: This denotes important information that, if unheeded, could hinder use 
of Net Station.

Troubleshooting, Support, and Repair
• For online updates to this book, check EGI’s 

Documentation page at www.egi.com/
documentation.html.

• For Net Station EEG software support, see 
Appendix A, "Software Technical Support.”

• To update your Net Station license, see 
Appendix B, "Updating EGI Licenses.”

Starting Net Station

How to start Net Station is discussed as part of the tutorial, as Step 1 of “Opening Net 
Station Data Files” on page 34.

The EGI Documentation page at 
www.egi.com/documentation.html
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INTRODUCTION 
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chapter 1

CHAPTER 1THE TUTORIAL DATA

he data that you will be analyzing as you go through this tutorial are from an 
auditory target detection (ATD) experiment (also known as auditory oddball or 

auditory P300). 

This is a classic paradigm that produces some of the best-studied ERP components, 
including the auditory N100, a late auditory-cortex component, and the P300, 
typically elicited by task-relevant oddball stimuli of any sensory modality. 

In this paradigm, the subject is presented with a series of frequent low-pitch tones 
(standards) occurring 80% of the time and infrequent higher-pitch tones (targets, 
sometimes referred to as oddballs or deviants) occurring 20% of the time. The subject is 
instructed to press a button immediately after each target tone. 

The order of the tones is random, with the constraint that targets be separated by no 
fewer than two and no more than six standards. The duration between the tones 
varies randomly between 600 and 900 milliseconds. 

The experiment begins with 10 practice trials. The trials contain an equal number of 
standard and target tones. 

The Net Station recording files contain the EEG voltage samples as well as other 
information, most importantly the event markers for all the standard and target tones 
and subject responses. 

The EEG data were recorded using a 256-channel Geodesic EEG System 200. The 
sampling rate was 250 samples per second. 

T
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Psychology Software Tool’s E-Prime was used as the experiment control program. 

In other words, E-Prime was used for:

• coding the experiment
• running the experiment, presenting the stimuli to the subject, and collecting the 

responses
• sending the stimulus event and response event information to Net Station

In this tutorial, you will:

• analyze ATD data from four subjects
• learn how to use Net Station to explore continuous recordings
• derive and explore ERPs, including the auditory N100 and the P300
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chapter 2

CHAPTER 2IMPORTANT TERMS 
AND CONCEPTS

he ATD experiment, and virtually all ERP experiments, consists of a sequence of 
trials. Each trial is a short sequence of stimulus events and/or response events. 

Trials generally have durations lasting from about a half-second to several seconds. 
Experiments are typically designed such that the trials share many similarities while 
also having strategic differences. The collection of trials is divided into different cells, 
based on one or more of the differences. 

For example, in the ATD experiment, the trials are similar to each other in that:

• They all contain a tone stimulus that occurs between 600 and 900 milliseconds 
from the tone stimulus of the previous trial. 

• The tone stimulus is followed by a period where a response (or nonresponse) 
from the user is collected. 

Table 2-1 displays the way the trials differ from each other.

The trials in the ATD experiment are divided into two different cells: standard and 
target. When you create your experiment in E-Prime, for example, you determine how 
the trials are divided into cells. 

Table 2-1. ATD trial differences

Tone stimulus Correct behavior Frequency

Standard Low pitch Do nothing 80%

Target High pitch Push button 20%

T
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Net Station recordings contain an event marker for each event in the experiment. The 
event markers indicate when each event occurs. Each event marker uses a four-
character event code to indicate which event it represents. When you create your 
experiment, you determine which event codes are used for which events. 

In the ATD experiment:

• Standard tone events have the event code ast_ (auditory standard).

• Target tone events have the event code atg_ (auditory target).

• Standard tone events in the practice trials have the event code astp (auditory 
standard practice).

• Target tone events in the practice trials have the event code atgp (auditory 
target practice).

• All responses have the event code resp. 

Event markers contain additional information as well (e.g., which cell the trial is in). 

For each trial in the experiment, Net Station recordings also contain trial specifications 
or trial-specific information (TRSPs). TRSPs contain the following information about 
the trial: 

• rsp#: which key was pressed (if any)
• rtim: the reaction time (if applicable)
• eval: an evaluation of the response (correct or incorrect)

When you code your experiment, you can add additional information to the trial 
specification (e.g., what stimulus was presented or percent-of-trials-correct so far). 

When you prepare to analyze your data, you conceptually divide your trials into 
different conditions based on criteria. The cell of a trial is usually included in the 
criteria, but not necessarily. For example, in the ATD experiment, you might have the 
conditions listed in Table 2-2.
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When you analyze your data, your objective is to derive ERPs, which are patterns of 
electrical activity on the scalp. Generated by the brain, ERPs occur in response to, or in 
preparation for, a discrete sensory, cognitive, or motor event that takes place during a 
specific experimental condition. 

Other than the optional technique of filtering, the first step in deriving ERPs from a 
data set is segmentation. In segmentation, you reduce your data to segments (short 
epochs) that fall into different categories. A category is defined by both the condition 
of the trial and the specific event to which the segment is temporally referenced. 

For example, you may be interested in the trials whose condition is target trials in 
which the subject made a correct response. You can make two different categories of 
segments from trials of this condition. One category would be temporally referenced 
to the tone stimulus (the atg_ event), and the other would be temporally referenced to 
the response (the resp event). 

The preceding discussion describes the recommended experiment structure, which is 
used in the vast majority of cases. If necessary, you can create an experiment with a 
different structure. 

You will learn more about how event markers and TRSPs are stored in a Net Station 
recording in Chapter 6, "Inspecting Event Data.” You will learn more about 
segmentation in Chapter 9, "Segmentation.”

Table 2-2. Sample conditions

Condition description Criteria

Trials in which the subject made a correct 
response

TRSP eval = correct

Trials in which the subject made an incorrect 
response

TRSP eval = incorrect

Standard trials cell = standard

Target trials cell = target

Standard trials in which the subject made a 
correct response

TRSP eval = correct AND cell = standard

Standard trials in which the subject made an 
incorrect response

TRSP eval = incorrect AND cell = standard

Target trials in which the subject made a correct 
response

TRSP eval = correct AND cell = target

Target trials in which the subject made an 
incorrect response

TRSP eval = incorrect AND cell = target
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Before proceeding to the next chapter, it is important that you understand the 
following terms that were introduced in this chapter: 

• trial
• cell
• event marker
• event code
• trial specification
• condition
• criteria
• ERP
• segmentation
• segment
• category
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SECTION II: 

EXPLORING
UNPROCESSED 
CONTINUOUS DATA
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chapter 3

CHAPTER 3INTRODUCING THE 
NET STATION VIEWER

et Station Viewer consists of the feature set you use for viewing, and navigating 
through, EEG and ERP data. The Viewer window is the main window of the 

Net Station Viewer. It is very similar to the Dense Waveform Display, the window you 
use when acquiring data with Net Station. 

In this section, you will learn to use Net Station Viewer to:

• inspect EEG (voltage) data
• recognize several types of noise
• inspect event data

By doing this, you will learn the basics of using Net Station Viewer and be prepared to 
understand Section III, “Deriving ERPs.”

The remainder of this chapter teaches you how to open data files in Net Station. 

Before You Begin

Obtaining the Tutorial Data Files
This tutorial uses Net Station recording files named: 

• ATD256_1.ses
• ATD256_2.ses
• ATD256_3.ses
• ATD256_4.ses

These files are available in the ERP Analysis Tutorial folder, which you can copy to 
your desktop from the Net Station installation CD.

N
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These files are also accessible from EGI’s Documentation webpage (www.egi.com/
documentation.html) or from EGI Support (see Appendix A, "Contacting EGI," on 
page 203).

Resetting Net Station to Its Default State
This tutorial assumes that you are starting with Net Station in its default state, 
otherwise, you may get results that appear different from those described. Net Station 
stores window states, settings, sizes, and locations from the most recent launch of 
Net Station in the following file: 

• Users:<user folder>:Library:Preferences:Net Station XX Preferences

Where XX is the Net Station version number (e.g., Net Station 4.2 Preferences). 

To reset Net Station to its default state, simply move the Net Station XX Preferences 
file from the System:preferences folder to another location. (Make sure Net Station is 
not running when you do this.) The next time you start Net Station, it will create a new 
Net Station XX Preferences file containing the default settings. You can then start the 
tutorial. To restore the original settings, move the original Net Station XX Preferences 
file back to the System:preferences folder (when Net Station is not running). 

Opening Net Station Data Files 

1 Start Net Station by double-clicking on the Net Station icon on the Finder 
Desktop. If the Net Station icon is in the Dock in Macintosh OS X, only a single 
click is needed (Figure 3-1). 

Figure 3-1. Starting Net Station

Net Station 
icon on the 
Desktop

Net Station 
icon in the 
Dock
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When Net Station is running with no files open, a start-up window is displayed with 
sections containing convenient shortcuts to the menu items for the different 
Net Station functions (Figure 3-2): 

• Open: for acquiring data with a new Session file or opening a data file with 
Net Station Viewer

• Tools: for using Net Station Waveform Tools or Photogrammetry
• Customize: for editing Session Templates or Acquisition Setups

There are a number of ways to open Net Station files in Net Station. You can use the 
standard Macintosh-application methods: 

• By using the file-selection dialog available when choosing File > Open or 
pressing Command-O (you can also access this dialog by clicking the Files 
button in the Net Station start-up window, shown in Figure 3-2).

• By double-clicking on the Net Station file in the Finder.

• By dragging the file from the Finder to the Net Station icon in the Finder. 

If you are unsure of your file location, or if you simply want to browse from possible 
files, you choose File > Find File. This feature is also available by clicking the Find 
Files button in the Net Station start-up window. 

Figure 3-2. The Net Station start-up window
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2 Click the Find Files button in the Net Station start-up window. 

3 From the Find File pop-up menu, choose “on local disks, except CD-ROMS”. 

4 Set the three pop-up menus of the middle panel to “kind is Net Station session” 
(Figure 3-3). 

5 Click the Find button. 

6 When the Find File Results window appears, select ATD256_1.ses by either 
double-clicking on it or clicking on it once and then clicking the Open button.

Note: If a dialog appears, stating that “this file is stored in an older format. . . .,” click the 
Convert button.

The Viewer window appears, displaying the data (Figure 3-4). 

Figure 3-3. Find File window

Figure 3-4. Viewer window in Chart view
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Net Station allows you to view the data in a variety of ways. You can see the selection 
of views by clicking on the View menu. Chart view, shown in Figure 3-4, is the view 
most similar to the one you have during acquisition. 

7 If you are not already in Chart view, choose View > as Chart. 

8 The Scale, Time, Events, Tracks, and Nav buttons below the title bar are control-
strip disclosure toggles. These buttons hide and display the associated control 
strips. Select all five control-strip disclosure toggles to display the associated 
control strips (see Figure 3-5 and the descriptions of the controls).

9 When finished viewing the control strips, select all five control-strip disclosure 
toggles to hide the associated control strips.

10 Close the file.

The following are brief descriptions of the numbered items from Figure 3-5. 

1.  Scale control strip. Allows you to adjust the time scale, amplitude scale, and 
polarity of the view. The Scale disclosure toggle hides and displays this control strip.

Figure 3-5. Viewer window with all five disclosure toggles selected

1

2

3

4

5

6

7

8

9



Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

3: Introducing the Net Station Viewer

38

2.  Time control strip. Allows you to control the time mode of the view. It also contains 
a timeline that gives feedback about where you are in the data. The Time disclosure 
toggle hides and displays this control strip.

3.  Events control strip. Allows you to see event markers that indicate the temporal 
location of events in the data. The Events disclosure toggle hides and displays this 
control strip.

4.  Tracks control strip. Allows you to see non-event information stored in the tracks 
of the data. (This information is also available in the File Info dialog opened by 
choosing Edit > File Info.) The Tracks disclosure toggle hides and displays this 
control strip.

5.  Data-display control strip. Contains controls that control various aspects of the 
appearance of the data display.

6.  Navigation control strip. Contains controls to navigate temporally through the 
data. The Nav disclosure toggle hides and displays this control strip.

7.  Link button. Allows you to synchronize multiple windows containing different 
views of the same data.

8.  Data display. Contents of the data-display area vary greatly, depending on the 
view used.

9.  Status bar. Displays information about the data being viewed.
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chapter 4

CHAPTER 4INSPECTING EEG

n this chapter, you will learn how to use the Net Station Viewer to view, and 
navigate in, continuous EEG in Chart view mode. 

1 If necessary, start Net Station, and open the file ATD256_1.ses. 

2 If you are not already in Chart view, choose View > as Chart.

Viewing the Data

1 Select the Scale control-strip disclosure toggle to display the Scale control strip 
beneath the control-strip disclosure toggles.

2 In the Amplitude Scale panel, use the two pop-up menus to choose 10 µV/mm 
and notice how this affects the waveform display. 

3 In the Polarity panel, if necessary, choose the positive-up button. Your choice in 
this panel affects the display only. The data file remains unchanged.

4 Select the Nav control-strip disclosure toggle to display the Navigation control 
strip at the bottom of the display.

In the Navigation control strip, directly under the data-display area, are the time ruler 
and slider. (To the left are the navigation controls.) The time ruler represents the 
timeline of the entire recording. The red horizontal line above the slider spans the 
window of time currently displayed in the Viewer. 

5 In the Time Scale panel of the Scale control strip, use the two pop-up menus to 
choose 60 mm/sec and notice how this affects the waveform display and the 
Navigation control strip’s time ruler. 

I

red line
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Note:  Screen aliasing occurs with any setting more than 1 sample/pixel. 

6 Select the Time control-strip disclosure toggle to display the Time control strip.

On the right side of the Time control strip is a timeline that contains labels and tick 
marks indicating the times within the recording of the underlying EEG samples. 

Net Station can display the labels in four different time modes: 

Absolute Time: time of and date according to the recording computer's internal 
clock, formatted as follows: yymmdd/hour:minute:second.ms. For example, 
020311/18:30:30.500 represents 30,500 milliseconds after 6:30 p.m. on 
March 11, 2002. 

Relative Time: the amount of time since the first sample in the file, formatted as 
follows: hour:minute:second.ms. For example, if in the previous example, the 
recording started at exactly 5:00 p.m., the Relative Time would be 01:30:30.500. 

Epoch Time: epoch number, in brackets, followed by the amount of time since 
the first sample in the epoch, formatted as above. For example, [2]01:30:30.500 
represents a sample that is recorded 1:30:30.500 into the beginning of the second 
epoch. 

Segment Time: for viewing segmented data. For nonsegmented data, this time 
mode is the same as Epoch Time. You will learn about this time mode in 
Chapter 9, "Segmentation.” 

You set the time mode using the Time menu. You can also change time modes with the 
time-mode button, the leftmost component of the Time control strip. Clicking this 
button cycles through the four time modes. 

The time mode affects the labels on the Time control strip and the status bar. The time 
ruler of the Navigation control strip is always in Relative Time mode. For inspecting 
continuous data, Relative Time mode is the most useful because the labels are in the 
same timeframe as the time ruler in the Navigation control strip. 

7 If necessary, choose Time > Relative Time. 

The leftmost time on the Time control-strip timeline corresponds to the left of the red 
horizontal line above the Navigation control-strip slider. Likewise, the rightmost time 
on the Time control-strip timeline corresponds to the right of the red horizontal line 
above the Navigation control-strip slider. 
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To the right of the time-mode button on the Time control strip are two time numbers:

• The top number represents the duration of the portion of the recording being 
displayed. This duration can be revised by changing the current time scale (as 
selected on the Scale control strip).

• The bottom number represents the total duration of the recorded file.

The disclosure triangle at the far left of the Time control strip allows you to choose 
between displaying one or two timelines. If you choose the two-timeline option, the 
top line simply indicates the point in recording time associated with the blue vertical 
line just beneath it on the lower timeline.

Navigating through the Data

You can scroll to any time window by dragging the Navigation control-strip slider 
until the red line spans the time window you desire.

As you are dragging the slider, the status bar under the slider updates to provide you 
with additional precise feedback about the time window to which you are scrolling. 
From left to right, the times displayed in the status bar are the time of the leftmost 
EEG sample, the time of the EEG sample at the center of the window, and the time of 
the rightmost EEG sample (Figure 4-1).

Figure 4-1. Status bar during navigation

leftmost sample, center sample, rightmost sample
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You can also use the navigation controls (Figure 4-2) to the left of the ruler to scroll 
through your data. 

The following are brief descriptions of the numbered items from Figure 4-2. 

1.  Go To Beginning button. Rewinds to the beginning of the recording. 

2.  Page Back button. Rewinds a whole page length. 

3.  Half-Page Back button. Rewinds a half-page length. 

4.  Half-Page Forward button. Advances a half-page length. 

5.  Page Forward button. Advances a whole page length. 

6.  Go To End button. Advances to the end of the recording. 

7.  Play Slow toggle. Toggles slow, smooth playback on and off. When on, the 
appearance is similar to the appearance of the Dense Waveform Display during 
acquisition. 

8.  Play Fast toggle. Toggles fast, smooth playback on and off. When on, the 
appearance is similar to the appearance of the Dense Waveform Display during 
acquisition. 

9.  Play Page toggle. Toggles paging (automatic, repeated full-page advance) on and 
off.

There is one additional way to scroll through the data. If you press the Control key 
while the cursor is over the data-display area, then the cursor takes the shape of a 
hand. You can then scroll through the data vertically and horizontally by dragging. 
Note that the Navigation control strip does not need to be displayed. 

Experiment with different methods of navigating through the data. 

Figure 4-2. Navigation buttons

   1      2      3      4     5     6

   7     8      9
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EEG Selection

Net Station uses a vertical line as a selection cursor to indicate the sample or samples 
that are selected. When you first open a recording for viewing, the first sample is 
selected. 

1 Click anywhere in the data-display area. 

Note that the vertical selection cursor appears where you clicked. 

Net Station allows you to make an extended selection of a contiguous epoch of data. 

2 Drag across an area of the data display. 

Note: Or you can use Shift-click to make an extended selection. Click anywhere in the 
data-display area. Then, while pressing the Shift key, click somewhere else. 

As you scroll through the data, Net Station does not move the selection cursor. In 
other words, it is possible for the selection cursor to be outside the window. You can 
select an epoch of data that is bigger than a full page by using the Shift-click method 
of creating an extended selection. 

Some of the things you can do with a selection are:

• save the selected data to a separate file by choosing File > Save Selection 

• fill the EEG display (changing the time scale and the position of the slider in the 
Navigation control strip) with the selected data by choosing Time > Zoom 
Selection To Window

• operate on the data using Waveform Tools (discussed in Section III, “Deriving 
ERPs”)

3 Click anywhere in the data-display area to deselect the selection.

4 Close the file.
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chapter 5

CHAPTER 5RECOGNIZING NOISE

n this chapter, you will learn how to recognize different types of noise, while 
becoming familiar with more features of the Net Station Viewer.

Noise is broadly defined as those portions of the data that are not of interest to the 
researcher or those that do not originate in the system of interest. With respect to EEG, 
this means extracerebral contributions to the data. With respect to ERP waveforms, 
this additionally includes contributions to the EEG data unrelated to the event of 
interest. 

We define an artifact as a special type of noise (specifically, large, isolated noise 
activity) often with specific, easily recognizable signatures, such as the contribution of 
a blink to the EEG data. (Note that some authors use the term artifact interchangeably 
with noise.) 

Noise and artifacts can be generated by either biologic or nonbiologic sources. 

In this chapter, you will learn how to recognize 

• 50 Hz or 60 Hz line noise
• bad channels
• eye-blink artifacts

In the ERP derivation process, you eliminate these and other sources of noise, and 
greatly increase the signal-to-noise ratio, through a series of automatic processes. You 
will learn about this in Section III, “Deriving ERPs.” However, it is useful to be able to 
recognize noise in the unprocessed, continuous recording. (The ability to recognize 
noise can also help you prevent noise when acquiring data.) Please keep in mind that 
this chapter covers some of the most important types of noise, but it is not a 
comprehensive guide. 

I
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If necessary, do the following: 

1 Start Net Station. 

2 Open the file ATD256_1.ses. 

3 In the Scale control strip, use the Amplitude Scale panel to scale the data to 
10 µV/mm and use the Time Scale panel to scale the data to 60 mm/sec. 

Recognizing Line Noise

In today’s world, surrounded by electrical equipment, the environment is filled with a 
narrowband electrical field generated by electrical lines. The activity of this field is 
50 Hz in most countries and 60 Hz in the United States and several other countries. 
This field is a source of noise in the EEG. The noise is easily filtered out. 

In this section, you will learn to recognize this line noise and, in the process, learn 
about Net Station’s filters, linked-window feature, and channel highlighting. 

Net Station allows you to view data in several different ways simultaneously. You do 
this by bringing up several windows with the same data. Then, you can change the 
settings, such as view, scale, filter, and montage, of each window individually. If you 
want the windows to stay in synch with each other as you navigate through the data, 
you can link them together. 

Linking Windows
1 Create a new window with the data by choosing View > Open New Window. 

2 Stack the two windows, with one window above the other. 

You now have two independent views of the same data. Next, link them together. 

3 Select the Link button (which features the chain icon) in the upper-right corner 
of both windows. 

4 To save space on the screen, hide all the control strips in both windows. In the 
bottom window, click the Nav control-strip disclosure toggle, to display the 
Navigation control strip. 
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Now, if you navigate through the data in either window, the other window will stay 
in synch. 

Comparing Windows
You can filter the data in one view, while leaving the other view unfiltered. Because 
these data were recorded in the United States, use the 60 Hz notch filter. 

1 In the bottom window, choose Filter > 60Hz Notch. 

2 Scroll both windows vertically until channel 25 is visible. 

Note the difference between the data in the two windows, especially in channel 25, 
which is near the common ground. 

You can use channel highlighting in both windows to make it easier to compare the 
filtered and unfiltered channel 25. To the left of the data display is a column of gray 
channel tiles that include a column of label tiles to the left. You can highlight any 
channel by clicking on the label tile. This turns the channel data red. 

3 In both windows, highlight channel 25 by clicking on its label tile. 

Figure 5-1 shows what your two windows should now look like. 

Figure 5-1. Linked filter window
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Note: A 60 Hz filter actually filters more than that single frequency. In this case, the 
60 Hz notch filters 59–61 Hz and attenuates down to 57 Hz and up to 63 Hz. 

4 Close the top Viewer window. 

5 In the remaining window, turn off the 60 Hz notch filter by choosing None from 
the Filter pop-up menu above the data-display area(Figure 5-2) and click on the 
label tile of channel 25 to remove the highlighting. 

This filter affects the display only. It does not change your data. Net Station allows 
you to save your data with the filter applied. If you want to do this, choose File > 
Save A Copy As to open the Save File As dialog, and select the Apply Viewer 
Transformations checkbox before clicking the Save As button. 

However, there is no need to save the filtered data at this stage. When deriving ERPs, 
you eliminate the line noise with the Filtering tool by using either a notch filter at 50 
or 60 Hz or a lowpass filter at a setting below 50 or 60 Hz. 

Net Station uses an infinite impulse response (IIR) filter for viewing. IIR filters are 
suitable for real-time use because of their excellent computational speed. This allows 
you to rapidly change filter settings and see the results. IIR filters have the 
disadvantage, however, of distorting the data because they lack a linear phase 
response.

Figure 5-2. Remove the notch filter
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When you save your data with your filter settings applied, Net Station uses a finite 
impulse response (FIR) filter. FIR filters are generally too slow for use in real-time 
applications, but their phase response is linear, making them superior for 
permanently filtering a file with the greatest possible accuracy. 

Note: You can use the Filter pop-up menu (see Figure 5-2) in the data-display control 
strip to choose from a variety of filter settings. If you require more detailed control of the 
filtering, you can use the various items in the Filter menu, including Show Filter 
Controls and Filter Options.

Recognizing Bad Channels

Bad channels contain data consisting entirely, or almost entirely, of noise. A typical 
recording contains some bad channels, perhaps because the sensors are defective 
(from normal wear and tear, for example) or because the sensors are dry or 
improperly placed on the subject’s scalp. 

The main symptoms of bad channels are:

• lots of line noise (50 or 60 Hz)
• amplitudes much bigger than the other channels
• amplitude shifts much bigger than the other channels

In this section of the chapter, you will learn to recognize bad channels and, in the 
process, learn about features of the channel tiles. 

1 Use the vertical scroll bar to scroll so that channels 51, 75, and 76 are all visible. 

Channel 51 is very bad. In fact, the amplitudes are so large and variable that it is 
difficult to tell which channel is the bad one. If you see a bad channel and have 
difficulty determining which channel it is, you can use the channel tile to highlight 
channels until you locate the bad one. 

2 Highlight channels 51, 75, and 76 by clicking on their label tiles. 

Figure 5-3 shows these channels highlighted. 
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Channel 51 is so bad that it disrupts your view of nearby channels. The rightmost 
column of channel tiles contains the hide/show channel toggles. They allow you to 
hide and display channels. An eye icon in that column indicates that the channel is 
displayed. Clicking the tile toggles between hidden and displayed. This affects the 
view only. Hiding a channel does not delete the associated channel data. 

3 Hide channel 51 by clicking on its hide/show toggle. 

Now look at channels 75 and 76. These channels look bad because there is a 
particularly large amount of 60 Hz line noise. 

4 Turn the 60 Hz notch filter back on by choosing it from the Filter pop-up menu 
in the data-display control strip. 

Figure 5-3. Channels 51, 75, and 76 highlighted

Hide/show 
channel toggles

Bad 
channel 
toggles
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Notice that with the notch filter on, channels 75 and 76 resemble their neighbors. 
These channels should not be marked bad because with the 60 Hz noise filtered out, 
they contain good data. 

5 Display channel 51 by clicking on its hide/show toggle. 

Channel 51 still looks bad even with the 60 Hz noise removed (Figure 5-4). 

The middle column of channel tiles contains the bad channel toggles (see Figure 5-3). 
They allow you to manually mark a channel as bad. A red slash-circle icon in that 
column indicates that the channel is marked bad. Clicking the tile toggles the bad 
channel marker on and off. 

Figure 5-4. Channels 51, 75, and 76, with notch filter applied

Channels 75 and 76 look 
good after applying the 
notch filter.

Channel 51 still looks 
bad after applying the 
notch filter.
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When deriving ERPs, you automatically eliminate bad channels by using the Artifact 
Detection tool to detect them, followed by the Bad Channel Replacement tool to 
replace them with data interpolated from the remaining channels. You will learn to do 
this in Chapter 10, "Artifact Detection,” and Chapter 11, "Bad Channel Replacement.” 
You will also learn other ways to recognize bad channels in those chapters. 

Because you will be automatically detecting bad channels later, leave channel 51 
unmarked for now. 

6 Click on the label tiles of channel 51, 75, and 76 to remove the highlighting.

Recognizing Eye-blink Artifacts

Voltage potentials of the eyeball add a high-amplitude artifact during an eye blink or 
eye movement. These eye artifacts affect all channels, but they are greatest in the 
channels near the eyes. 

In this section of the chapter, you will learn to recognize eye-blink artifacts and, in the 
process, learn about montages and user events. 

Applying the Eyes Montage
1 Use the Navigation control strip to scroll to time 40.8 in the data. 

Net Station’s Montage feature allows you to create and edit montages and to select 
from existing montages. Individual channels can be selected, their display order 
reorganized, and each rereferenced to either a single common electrode or any bipolar 
combination of electrodes. To simplify the finding of ocular artifacts, use the existing 
Eyes montage. 

2 From the Montage pop-up menu above the data-display area, choose Eyes. 

If necessary, you can give each channel more space by dragging the bottom edge of 
any channel tile. 

3 Make the channels wider to avoid overlapping of channel data. 
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Inserting an Eye-blink Event
You will now add an eye-blink event to the recording for the blink epoch. 

1 Drag the cursor across the blink epoch to create an extended selection as shown 
in Figure 5-7.

2 Select the Events control-strip disclosure toggle to display the Events control 
strip. 

Notice the series of labeled buttons in the Events control strip, above the Experimental 
Computer Interface (ECI) track (Figure 5-5). These buttons are for creating user-
inserted events. 

3 Click the button labeled eyeb. 

Net Station cautions you that the file has no user event tracks and asks you if you 
want to create one. 

4 Click OK to create the track. 

An input box appears, allowing you to name the new user event track. 

5 Type “user” and click the New button.

The new user track appears with the epoch that you selected marked as a blink 
(Figure 5-6). 

Figure 5-5. User event buttons in the Events control strip

Figure 5-6. An eye blink in the User track

User events

User 
track

Epoch marked as an eye blink



Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

5: Recognizing Noise

54

Your Viewer window should now look similar to Figure 5-7. Note that there is a 
positivity in channels 36 and 18, which are above the eyes, and a negativity in 
channels 242 and 241, which are below the eyes. 

6 Return to the default montage Geodesic Sensor Net 256 2.0, and drag the 
channel tiles to their normal width. Click anywhere in the data-display area to 
deselect the selection.

7 Close the file.

Normally, when deriving an ERP, you do not have to manually find and mark blink 
artifacts. When deriving ERPs, you eliminate eye artifacts through the automatic 
detection and rejection of segments that are contaminated by them. 

Figure 5-7. A blink event in the Viewer window

Above 
the eyes

Below 
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chapter 6

CHAPTER 6INSPECTING 
EVENT DATA 

n this chapter, you will learn how the event information discussed in Chapter 5, 
"Recognizing Noise,” is stored in a Net Station recording. 

Opening the Event List Window

1 Open the file ATD256_1.ses.

2 If necessary, select the Events control-strip disclosure toggle to display the 
Events control strip. 

At the bottom of the Events control strip is the ECI track. This track contains markers 
for all of the events transmitted by the experimental control computer. The purpose of 
the events is to indicate the timepoints/samples where specific stimulus and response 
events took place during the recording, as well as information about those events. 
Net Station lets you view event information in a variety of ways. 

3 Choose Events > Event List.

The Event List window, depicted in Figure 6-2, appears. 

Figure 6-1. ECI track of the Events control strip

I
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The following are brief descriptions of the numbered items from Figure 6-2. 

1.  Header events. Contain information that is general to the entire recording.

2.  Events from first (practice) trial, with disclosure triangles toggled to reveal 
metadata, such as the cell number of the trial, response key pressed, response time, 
and whether the response was correct or incorrect.

Figure 6-2. Event List window

1

2

codes and labels
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The Event List window gives you another view of the events in the ECI track. Note 
that the first two columns in the Event List are Codes and Label. Codes are limited to 
being exactly four characters long. In the ECI track, for events with labels, the labels 
appear on the event markers. Otherwise, the codes appear on the event markers. 

The header events in Figure 6-2 are the 1 SESS event and 6 CELL events and appear at 
the top of the list. These events contain information that is general to the entire 
recording. 

Exploring the Event List

1 Click on the disclosure triangle to the left of the first SESS event.

In this expanded view, you can see the key list that is included within the event. The 
key list contains metadata about the event. In this case, the metadata consist of subject 
information and the number of cells (Figure 6-3). 

2 Click on the disclosure triangle again to collapse the event.

3 Click on the disclosure triangles next to the CELL events whose labels are 
ATDTarget, ATDStandard, ATDTargetPrac, and ATDStandardPrac (Figure 6-4). 
(The ART and ARTPrac CELL events refer to cells that are absent in these 
recordings.)

Figure 6-3. SESS key list
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The purpose of these CELL events is to associate a cell number with each cell. Notice 
that the metadata for these CELL events contain a cel# (cell number) key. Notice that 
the cell numbers for these cells are as follows: 

• ATDTarget (target): 2
• ATDStandard (standard): 3
• ATDTargetPrac (target practice): 5
• ATDStandardPrac (standard practice): 6

Next, look at the events that follow the header events. These are repeating sequences 
of events that start with bgin (begin) events and end with TRSP (trial specification) 
events (Figure 6-5). Each of these sequences represents a single trial. Between the bgin 
and TRSP events are the stimulus and response events for the trial. 

Figure 6-4. CELL key lists

Figure 6-5. Events of one trial

Start of trial

Trial data 
(such as 
whether the 
response is 
correct)

Stimulus

Response
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Recall from Section I, “Introduction,” that every trial contains a stimulus event, which 
is either a standard tone or a target tone. Standard-tone events have the code ast_ 
(auditory standard) or, for the practice trials, astp (auditory standard practice). Target-
tone events have the code atg_ (auditory target) or, for the practice trials, atgp 
(auditory target practice). 

The response events have the code resp. Because the subjects were instructed to make 
a response after the target tones, the correct trials either

• contain an atg_ event (or atgp) and a resp event, or
• contain an ast_ event (or astp) and no resp event

Similarly, incorrect trials either

• contain an atg_ event (or atgp) and no resp event, or
• contain an ast_ event (or astp) and a resp event

4 Scroll down through the Event List and click on the disclosure triangle of any 
event. 

By looking at the cel# metadata, you immediately know into which cell that event, 
and all the events from the trial, falls. The obs# metadata tell you how many trials 
from that cell have occurred. For example, if the cel# is 6 and the obs# is 1, then it is 
the 1st trial from the ATD standard practice cell (Figure 6-6). 

5 Click on the disclosure triangle of all events from a trial. In other words, start 
with a bgin event and continue until you get to a TRSP event (see Figure 6-2). 

Notice that all the events in the trial have the same cel# and obs# metadata. Also note 
that the metadata from the TRSP event include the following keys: 

• rsp#: which key was pressed (if any)
• eval: an evaluation of the response (correct or incorrect)
• rtim: the reaction time (if applicable)

In this experiment, an eval value of 1 means correct, and 2 means incorrect. 

6 Click on the disclosure triangles again to close all open events.

Figure 6-6. Cel# and obs# metadata
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Opening the Filter Events Window

1 Click the Filter Events button near the top of the Event List. 

The Filter Events window, shown in Figure 6-7, appears.

In this window, you can see a summary of how many different events are in this file 
and how often they occur. Notice that the eyeb event that you added in the previous 
chapter is there. Also notice that there are 317 ast_ events and 83 atg_ events, as you 
would expect. Note that there are 86 resp events, which is approximately equal to the 
number of atg_ and atgp events. This indicates that the subject was probably doing 
what he or she was supposed to do. 

You can verify this further by checking that the resp events generally follow the target 
(atg_ and atgp) events. The Filter Events window allows you to do this easily. First, 
you want to hide all the events except ast_, astp, atg_, atgp, and resp. 

2 At the top of the right column, labeled List, click the button with the minus 
sign, to clear all the entries in the column. 

Figure 6-7. Filter Events window

Eye-blink event
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3 In the List column, click the cells for these events: ast_, astp, atg_, atgp, and 
resp. 

4 Click the OK button, which dismisses the Filter Events window, to display 
an Event List containing only the ast_, atg_, atgp, and resp events (Figure 6-8). 

By scrolling through the Event List, populated by only the events of interest, you can 
easily see that the subject’s behavior was correct in the vast majority of cases. 

Figure 6-8. An Event List with only events of interest
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Opening the Event Editor Window

Another way to view information about events is through the Event editor. You can 
access this window through the Event List or the ECI track. 

1 Double-click on any event in the Event List. 

The Event editor, shown in Figure 6-9, appears, providing a different view of the 
event. 

2 Click Cancel to dismiss the Event editor and return to the Event List. 

3 Click on any event in the Event List and click the Go To Event button in the 
upper-left corner of the window. 

Figure 6-9. Event editor 
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The EEG display becomes active and scrolls to the sample of the event (Figure 6-10). 

4 Double-click on the event in the ECI track. 

Again, the Event editor appears. You can use this to get information about an event 
when the Event List window is closed. 

5 Dismiss the Event editor and close the file.

You will revisit these events again in Chapter 9, "Segmentation.”

Figure 6-10. Go To Event button takes the user to the selected event in the Viewer
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SECTION III: 
DERIVING ERPS
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chapter 7

CHAPTER 7ERP DERIVATION AND 
WAVEFORM TOOLS

ERP Derivation Overview

n event-related potential (or ERP) is a pattern of electrical activity on the scalp, 
generated by the brain, that occurs in response to, or in preparation for, a discrete 

sensory, cognitive, or motor event that occurs during a specific experimental 
condition. 

In the EEG from a single event from a single experimental trial, the ERP signal 
generated by the brain is swamped by many types of noise, including: 

• background brain activity unrelated to the event or experimental condition

• artifacts, such as those generated by eye blinks, heart activity, muscle activity, 
eye movement, and head movement

• line noise

• data from bad channels

(See Chapter 5, "Recognizing Noise,” for definitions of noise and artifacts.) 

That is why an EEG recording for an ERP experiment consists of tens, hundreds, or 
thousands of repetitions of the events of interest. From this recording, you can derive 
ERPs by averaging all the trials of a given condition, time-locking to the event of 
interest. This increases the signal-to-noise ratio because activity not related to the 
event averages to zero. The result from this is a single-subject average, or ERP, for each 
event of interest in the experiment. 

Once you have ERPs from more than one subject, you can create grand-average ERPs 
by averaging together the averages for the individual subjects. Grand averaging 
emphasizes the ERP patterns shared by all the subjects and deemphasizes individual 
differences. 

A
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ERP Derivation Operations

To derive a single-subject ERP from your continuous recording, you normally 
perform the following operations: filtering, segmentation, artifact detection, bad 
channel replacement, averaging, average referencing, and baseline correction.

Note: This tutorial does not cover some of the advanced Waveform Tools and Viewer 
options, such as Markup from File, Ocular Artifact Removal, Short Epoch Filtering, 
t-test, Wavelet, Spectral Display, and video EEG. These tools represent operations that are 
not part of the core data-analysis path used to derive ERPs. 

Caution!: Before averaging, make sure that you have assigned a subject to the file 
to ensure that the subject information remains available for subsequent Waveform 
Tools operations, such as Averaging. Assigning a subject after averaging is not 
recommended. The “Assigning Subjects” section in Chapter 1, “The Waveform 
Tools Window,” of the Net Station Waveform Tools Technical Manual discusses 
this topic in more detail. 

Each operation serves a specific signal-processing purpose, mostly related to 
increasing the signal-to-noise ratio. Each operation also outputs a version of the data 
that is used as the input to the operation that follows it. 

• Filtering: In this operation, you filter out activity in frequencies that are not of 
interest. Traditional ERP research, for example, has focused on brain activity in 
frequencies below 30 or 40 Hz. Note that if you do a lowpass filter in this range, 
then the 50 Hz or 60 Hz line noise will be filtered out, so there is no need to do a 
notch filter. You will learn how to do this in Chapter 8, "Filtering and Using 
Waveform Tools.” 

• Segmentation: In this operation, you reduce your data to segments (short 
epochs) that fall into different categories. You define the criteria for the 
categories. Each category is temporally referenced to an event of interest, for a 
specific experimental condition of interest. You specify the duration, before and 
after the event, to include in the segment. You will learn how to do this in 
Chapter 9, "Segmentation.” 

• Artifact detection: In this operation, you automatically detect and mark bad 
channels and bad segments (segments that are contaminated by artifacts). You 
will learn how to do this in Chapter 10, "Artifact Detection.” 

• Bad channel replacement: In this operation, you replace the data in bad channels 
with data interpolated from the remaining channels. Bad channel replacement 
is based on the idea that, because of electrical volume conduction, channels in 
proximity to each other have similar data. This approximation increases in 
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validity as channel count increases. For 128 or 256 channels, the results of bad 
channel replacement are quite good, but for channel counts less than 64, 
considerable and serious errors exist in the reconstructed data. You will learn 
how to replace bad channel data in Chapter 11, "Bad Channel Replacement.”

• Averaging: In this operation, you calculate a single, average segment from all 
the segments that were not rejected, for each category that you created during 
segmentation. You will learn how to do this in Chapter 12, "Averaging.” 

• Average referencing: In this operation, you rereference the data to an average of 
all the channels. The purpose of average referencing is to minimize the 
influence of the arbitrary recording reference channel on the data set. Also, 
because of the dipolar nature of brain sources, the average voltage over the 
entire surface of the head is zero. As channel counts increase, the average of all 
the channels approaches this ideal zero reference. You will learn how to do this 
in Chapter 13, "Average Referencing.” 

• Baseline correction: In this operation, you establish a baseline interval within 
your segment. You select the interval to use as the baseline. For stimulus events, 
the baseline interval normally precedes the stimulus. For each channel, the 
average of all the samples within the baseline interval is subtracted from every 
sample in the segment. This baseline value establishes a new zero-voltage 
value. You will learn how to do this in Chapter 14, "Baseline Correction.” 

Most of the operations require you to specify parameters. For example, filtering 
requires you to specify the frequencies to filter out. 

Data-Analysis Path Issues

We define data-analysis path as the order in which you perform the operations, and 
the parameters. In this tutorial, you will perform the operations in the order listed in 
the preceding "ERP Derivation Operations” section. 

For example, rereferencing and baseline correction are done after averaging. Although 
this is the same as performing rereferencing and baseline correction before averaging, 
it requires fewer computer resources. However, if you are interested in exploring 
individual trials, then you might prefer to do rereferencing and baseline correction 
before averaging. This tutorial assumes you are not interested in exploring individual 
trials. 
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It is best to design your data-analysis path so that the processed data that you are 
interested exploring are available in both the baseline-corrected and non-baseline-
corrected form. That way, you can understand the effects of the baseline correction. 
Note that you cannot undo the baseline-correction operation. Therefore, baseline 
correction should be done as the last step before exploring the processed data. 

For example, if you are interested in exploring both individual subject averages, and 
grand averages, the grand averages should be derived from the non-baseline-
corrected, individual-subject averages. The baseline correction can be performed 
separately on both the individual-subject averages and grand averages. That way, you 
will have both baseline-corrected and non-baseline-corrected versions of both the 
individual-subject averages and the grand averages. If you derive your grand average 
from baseline-corrected, individual-subject averages, you will not have a non-
baseline-corrected grand average. This approach is taken in the tutorial. 

When you start analyzing data from an experiment, it usually takes some trial and 
error to find the order of operations and parameters that is best for you. To determine 
your optimal data-analysis path, it is advisable to first carefully process the data from 
a single subject to 

• verify that you can do what you want to do (you may learn that you need to 
modify your experimental control script) and

• learn the effects of the various operations and their parameters

Once you have processed the data from one subject, you can process the data from the 
remaining subjects in a more automated fashion. This is the approach taken in this 
tutorial. In Chapters 8 through 14, you will learn to analyze the data from a single 
subject. Then, in Chapter 15, "Scripting,” you will learn how to automate the 
processing of the remaining subjects. 

Once you have ERPs from several subjects, you can create grand-average ERPs. You 
will learn how to do this in Chapter 16, "Combine and Grand Averaging.” 

Waveform Tools Overview

In Net Station, you perform all of these operations using Net Station Waveform Tools. 
Each Waveform Tool, except Script, represents a specific operation or a set of closely 
related operations. 
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Before you can use a tool, you must create a tool specification using the specification 
editor for the tool. In the specification editor, you edit fields to specify the operation 
parameters. For tools that create new files, as most tools do, you also specify the 
output options and the name and location of the output files in the specification 
editor. 

To perform an operation on your data, you first select the input data and tool 
specification and then run the tool. 

You use the Waveform Tools window to run the tool operations and to open tool 
specification editors for creating and editing tool specifications. In Chapter 8, 
"Filtering and Using Waveform Tools,” you will learn the basics of using Waveform 
Tools. The remaining chapters assume you know the basics taught in Chapter 8. 

Script is a special tool for automating your ERP derivation by chaining tool operations 
together. Script is similar to the other tools in that you use the Waveform Tools 
window to launch a scripting specification editor and to run the script. You will learn 
how to use the Script tool in Chapter 15, "Scripting.” 

Chapter Review

Before proceeding to the next chapter, it is important that you understand these terms, 
which were introduced in this chapter: 

• average ERP (single subject)
• filtering
• artifact detection
• averaging
• baseline correction
• operations
• data-analysis path
• tool specification
• output options
• grand-average ERP
• segmentation
• bad channel replacement
• average referencing
• grand averaging
• parameters
• Waveform Tools
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• tool specification editor
• scripting
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chapter 8

CHAPTER 8FILTERING AND USING 
WAVEFORM TOOLS

n filtering, you filter out activity in frequencies that are not of interest. Traditional 
ERP research, for example, has focused on brain activity in frequencies below 30 or 

40 Hz. Note that if you do a lowpass filter in this range, then the 50 Hz or 60 Hz line 
noise will be filtered out, so there is no need to apply a notch filter. 

Create a Filtering Specification

Before you can filter your recordings, you must create a Filtering specification. 

1 If necessary, start Net Station. 

To create a tool specification, you will open the Waveform Tools window (Figure 8-1), 
open a specification editor for the tool, name the specification, edit the output options 
(if applicable), edit the tool-specific parameter fields, and close the editor, saving the 
specification.

Editing the Specification
1 Open the Waveform Tools window. You can do this by choosing Tools > 

Waveform Tools. If the Net Station start-up window is present, you can also do 
this by clicking the Waveform Tools button.

2 Open a Filtering specification editor by clicking the Create button and choosing 
Filtering from the pop-up menu (see Figure 8-1).

I
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3 Name the Filtering specification “Lowpass 40 Hz” by editing the Filtering 
Specification Name text box. Deselect the Auto Set Name checkbox so the name 
you have chosen will not be overridden when you set the filter slider.

Edit the output options using the Output Options panel:

4 Set the name to Append “.40” as follows: Click the Name pop-up menu and 
choose Append Extension. When the input box appears, type “.40” and 
click OK. 

5 Set the destination to Same As Source by using the Destination pop-up menu.

Figure 8-1. Create a Filtering tool in the Waveform Tools window
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Setting the Tool-specific Parameters
Edit the Filter Settings panel in the middle of the specification editor:

1 Select the Lowpass checkbox to activate the slider.

2 Drag the Lowpass slider until the display to the right of the slider says 040.0.

Notice that you can also specify highpass and notch filters with this tool. To edit the 
Filtering specification further, click the Options button to open the Filter Options 
window (Figure 8-2). 

Figure 8-2 displays the default values for passband gain, stopband gain, and rolloff. 
This tutorial uses the default values so click OK to close the window and to return to 
the specification editor window.

3 The Cycle Channels checkbox is selected by default. Leave it selected. The 
Unfiltered and Filtered windows will automatically display one channel after 
another in numerical sequence if you use the Preview Filtering feature.

Your Filtering specification is now fully defined. Figure 8-3 shows the finished 
Filtering specification. 

Figure 8-2. Filter Options window
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4 Close the Filtering specification editor by clicking its close button (the red 
button in the upper-left corner of the window). When a dialog appears, asking 
if you want to save the changes, click Save. 

Your new specification appears in the Specifications panel of the Waveform Tools 
window. You can edit the parameters of a tool specification by double-clicking on the 
tool name, which opens the specification editor.

Figure 8-3. Filtering specification editor
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Run the Filtering Tool

To perform an operation on your data, you first select the input data and tool 
specification and then run the tool. 

1 Click the Add button in the Inputs panel of the Waveform Tools window. When 
the file-selection dialog appears, navigate to the file ATD256_1.ses and select it. 

2 Click Add. (Another way to add files to the Inputs list is to drag them there 
from the Finder.)

The file-selection dialog disappears, and the file you selected appears in the Inputs list 
(Figure 8-4). 

Figure 8-4. Choosing a tool and adding an input file in the Waveform Tools window
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3 In the Specifications panel of the Waveform Tools window, highlight the 
Lowpass 40 Hz specification by clicking on it.   

4 Click the Run button to begin filtering the file. (If you had wanted to run the 
filtering tool on multiple files, you would have added them to the Inputs pane, 
highlighted the Lowpass 40 Hz specification in the Specification pane, and then 
clicked Run.)

5 The Jobs and Results window automatically appears, allowing you to track the 
progress while the tool is running (Figure 8-5). 

The Jobs and Results window contains two tabbed panes. 

The Job Queue pane shows you the queue of jobs, the progress of the current job, and 
the results of all jobs run during the current Net Station session. If an error occurs, 
more information about the error is provided in the Results panel. This is particularly 
helpful if you are running multiple jobs. 

The Results pane allows you to view results in two ways: as Jobs, and as Result Items. 
For now, click the View as Jobs radio button. When your filtering job is completed, 
you should get a Results item with a green rectangle to the left, indicating success. 
(Errors are indicated by red rectangles.) 

Figure 8-5. Jobs and Results window
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View the Results

In this section of the chapter, you will view the results of filtering on your data by 
comparing the filtered file with the original file. 

1 Open the original file ATD256_1.ses in the Net Station Viewer. 

You can use the Jobs and Results window as a shortcut for opening files that are the 
results of operations performed in the current Net Station session. 

2 Open the result file ATD256_1.ses.40 by double-clicking on the entry in the 
Results pane of the Jobs and Results window. 

Arrange the two Viewer windows horizontally as you did in “Recognizing Line 
Noise” in Chapter 5. You can now compare the original data with the filtered data and 
see the results of the filtering. For the best comparison, apply the 60 Hz IIR notch filter 
to the original data, as you learned in Chapter 5 (Figure 8-6). 

Figure 8-6. Comparing the filtered (bottom) and unfiltered (top) data

Flattened 
data



Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

8: Filtering and Using Waveform Tools

80

Note that the first and last 560 ms of the filtered data are flattened. The Filtering tool 
does this because at the beginning and end of the file, there is not enough data to do 
filtering without distortion in the form of ringing. The number of samples that get 
flattened at the beginning and ending of the file depends on the filter’s rolloff. 

3 Close both files. 
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chapter 9

CHAPTER 9SEGMENTATION

n segmentation, you reduce your data to segments (short epochs) that fall into 
different categories. You define the criteria for the categories. Each category is 

temporally referenced to an event of interest, for a specific experimental condition of 
interest. You specify the duration, before and after the reference event, to include in 
the segment.

This chapter takes you through a simple segmentation example. Segmentation can 
become complicated, depending on the event or event duration on which you wish to 
segment. For more information, see the “Segmentation” chapter in the Net Station 
Waveform Tools Technical Manual.

Create a Segmentation Specification

Before you can segment your recordings, you must create a Segmentation 
specification.

Editing the Specification
1 If necessary, start Net Station and open the Waveform Tools window. 

2 Open a Segmentation specification editor and name the Segmentation 
specification “ATD Seg” (for auditory target detection segmentation).

I
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3 In the Output Options panel, set the name to Append “.sg” (for segmentation) 
and the destination to Same As Source (Figure 9-1). 

Note: To prevent overly long filenames, this tutorial uses extensions that are shorter than 
the default extensions (e.g., “.sg” instead of “.seg”).

Setting the Tool-specific Parameters
Next, you will define your segmentation rules. Your goal is to create two categories, 
each referenced to the stimulus-tone event: one for standards correct trials, and the 
other for targets correct trials. 

Because your desired categories are similar, you can save time by defining one 
category in full before proceeding to the other. Then, you can use the duplication 
feature to create the other category. 

1 In the Category list just below the Segmentation Settings label, click on 
Category 1. The name background will turn a different color, indicating that 
you can change the name. Type in “Standard Correct”. 

Now, edit the event criteria for this category, using the Criteria pane. 

2 Click the Browse button. 

Figure 9-1. Setting up the Segmentation specification editor
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The Browse Event Criteria window appears.

3 In the Browse Event Criteria window, click the Select button and select Other 
(Figure 9-2).

4 Navigate to the location of ATD256_1.ses.40 and either double-click on the file 
name or highlight the name and click the Open button. Net Station will begin 
compiling the event conditions from that file and placing them in the tabbed 
panels of the Browse Event Criteria window.

5 When Net Station is finished, click the tabs to view the information in each 
pane. Notice that the panes contain the same information provided in the Event 
List discussed in Chapter 6, "Inspecting Event Data,” except organized 
according to category (Figure 9-3). 

Figure 9-2. Browse Event Criteria window
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6 Click the Codes tab, and in the Codes pane look for ‘ast_’, the code that refers to 
the ATD standard condition. 

Figure 9-3. Event condition panes

Types Codes

Labels Tracks

Key Codes Key Labels

Specs Cells
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7 Click on the line that says Code is ‘ast_’ and drag it to the edit portion of the 
Criteria pane of the Segmentation specification editor. 

8 In the Browse Event Criteria window, click the Specs tab. You are now looking 
for the trial specification that refers to a correct trial. Based on the coding of the 
E-Prime experiment, Trial Spec ‘Response Evaluation’ is 1 is the correct trial 
specification. Drag this line to the edit portion of the Criteria pane (Figure 9-4). 

9 Close the Browse Event Criteria window by clicking its close button. 

If you know the event structure of the recording, you can do the equivalent of the 
preceding steps by dragging criteria icons from the top of the Criteria pane into the 
edit portion of the Criteria pane, and then filling in the input boxes. 

10 Select the Copy Specs To Segment checkbox to the left of the Browse button in 
the Segmentation specification editor. This causes each resulting segment to 
contain a copy of the trial-specification data associated with that segment. 

Now, specify how many milliseconds to keep before and after the stimulus onset.

11 Click on 1000 ms in the yellow time bar, to view the “segment length” pane.

12 Set the Segment Length Before box to 100 Milliseconds.

Figure 9-4. Populating the Criteria pane
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13 Set the Segment Length After box to 500 Milliseconds (Figure 9-5).

The Standard Correct category is now fully defined. 

Duplicating and Defining
Next, define the Target Correct category by duplicating and editing the first category. 

1 Duplicate the Standard Correct category by clicking the ++ button ( ). You 

will see a new category named Standard Correct Copy.

2 Click on this new category. The name background will change color, indicating 
that you can change the name. Type “Target Correct.”

3 The category is already defined in terms of criteria and segment length. All that 
remains to be done is to change the condition to correspond to the target 
stimulus rather than the standard stimulus. In the Criteria pane, change “ast_” 
to “atg_” to finish defining the Target Correct category.

Previewing the Specification
Before you close your specification, it is a good idea to preview segmentation. This 
gives you an opportunity to verify that your categories are defined correctly.

1 In the Preview Segmentation pane in the lower right of the Segmentation 
specification editor, click the Select button and select Other.

Figure 9-5. Specifying the segment length
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2 Navigate to ATD256_1.ses.40. Either double-click on the file name or highlight 
the name and click the Open button. 

3 Net Station will scan the file for the categories that you have defined. Verify 
that you see the following results (Figure 9-6):

• Standard Correct 317 segments 
• Target Correct 82 segments 

Your Segmentation specification is now fully defined. Figure 9-7 shows the finished 
Segmentation specification. 

4 Close the Segmentation specification editor, saving the changes. 

Figure 9-6. Previewing the Segmentation specification

Figure 9-7. A defined Segmentation specification

Net Station 
scans the file 
for the defined 
categories.

The results allow 
you to verify that 
the Segmentation 
specification is 
accurately defined.
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Note: In this experimental design, you can distinguish standard trials from target trials 
by the code for the stimulus event. Many experiments are designed with the following, 
different strategy: All stimulus events have the same code (e.g., ‘stim’) and the cell is used 
to distinguish standards from targets. In that case, the event criteria would be different. 
Standard trials would be those whose

• code is ‘stim' and
• cell is ‘Standard'

Target trials would be those whose

• code is ‘stim' and
• cell is ‘Target'

Note that the above criteria does not include the constraint that the trials are correct. 

Run the Segmentation Tool

In this section, you will run the Segmentation tool.

1 In the Waveform Tools window, add the ATD256_1.ses.40 file to the Inputs 
pane. There are several ways to do this: 

° Click the Add button in the Waveform Tools window and navigate to the file.

° If the file is still in the Results pane of the Jobs and Results window, drag it 
from there to the Inputs pane of the Waveform Tools window. 

° Drag it from the Finder into the Inputs pane of the Waveform Tools window.

2 Highlight the ATD Seg specification in the Specifications pane of the Waveform 
Tools window, and click the Run button.
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View the Results

In this section of the chapter, you will learn to use Net Station Viewer features to view 
segmented files, and learn how to mark artifacts manually. 

1 Open the result file ATD256_1.ses.40.sg.

2 If necessary, select the Navigation control-strip disclosure toggle to display the 
Navigation control strip (Figure 9-8). 

Notice that the data display contains equally spaced vertical lines. These lines 
separate the segments that you have created.

A useful way of viewing segments is as categories. This viewing option is available 
only for files that have been segmented.

3 Choose View > as Categories. 

Figure 9-8. Viewing segmented data

Line to 
separate 
segments
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With this viewing option, you see one segment at a time (Figure 9-9). Also, a new set 
of controls appears in the Navigation control strip. 

The category selector contains controls for traversing through the categories. The 
segment selector contains controls for traversing through the segments within the 
selected category. The controls to the left of the category selector step through all the 
segments sequentially, sorted by category.

Note that the category selector contains the two categories that you created in your 
Segmentation specification: Standard Correct and Target Correct. 

4 Select each category and notice how many segments appear in the segment 
selector. These are the same numbers (317 Standard Correct and 82 Target 
Correct) you saw earlier when you previewed the segmentation. 

5 Experiment with the different ways of navigating through the segments by 
clicking the various navigation buttons.

Figure 9-9. Viewing segmented data in “as Categories” mode

Category selector Segment selector

Controls for 
navigating in 
“as Categories” 
mode

Opens Segment 
Status palette
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The best time mode in which to view segmented data is Segment Time. In this mode, 
time zero for each segment is the sample containing the event to which the segment is 
temporally referenced. Samples before time zero have negative time values. 

6 Set the time mode to Segment Time by using either the Time menu or the Time 
control strip. 

When viewing “as Categories,” you can manually mark artifacts, such as: 

• marking segments bad
• marking channels bad in individual segments
• marking channels bad in all segments

This information is used in operations that you will perform later (for example, 
artifact detection and bad channel replacement). 

To mark segments bad, use the Segment Status palette. 

7 Open the Segment Status palette by clicking the Status button located in the 
lower right of the Navigation control strip (see Figure 9-9).

Note that the question mark button of the Segment 
Status palette is selected (Figure 9-10). This indicates 
that Net Station does not yet know the status of the 
segment (that is, if the segment is good or bad). Observe 
that the Segment Status icon to the left of the Status 
button in the Navigation control strip is also displaying 
a question mark. 

You can change the segment status with the Segment Status palette. To mark the 
segment good, click the green light icon. To mark the segment bad, click the red slash-
circle icon. To return the segment to the unknown status, click the question mark icon. 
The Segment Status icon to the left of the Status button in the Navigation control strip 
changes to reflect the setting. 

8 Click the disclosure triangle of the Segment Status palette.

Figure 9-10. 
Segment Status palette
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You now have a selection of status specifiers you can use to 
specify why segments are bad (Figure 9-11). These are 
dimmed (disabled) unless the channel is marked bad. You 
have the following choices: 

• badc: bad channel
• bads: bad segment
• comm: comment
• emg: electromyograph (muscle artifact)
• eye: eye-blink artifact
• eyem: eye-movement artifact
• moto: motion artifact
• nois: noisy segment

In this way you can mark by hand which segments you 
want in the rest of your analysis. However, in this tutorial, 
you will use the Artifact Detection tool to detect the bad 
segments for you. 

9 If necessary, return the segment status to the unknown status and close the 
Segment Status palette. 

Artifact Detection can set the following specifiers: badc, eyeb, and eyem. The other 
specifiers are available for manual use. 

To mark a channel bad manually in the segment current displayed in the Viewer, click 
the bad channel tile for the channel (Figure 9-12). 

Figure 9-12. Marking channels bad manually

Figure 9-11. Segment 
Status palette expanded

Select toggle to mark 
or unmark channel 
as bad in segment
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To mark a channel bad for the entire file, press the Option key while clicking the bad 
channel tile for that channel. When the cursor is hovering over a bad channel tile, it 
takes the form of the slash-circle icon. When you press the Option key while the 
cursor is hovering over a bad channel tile, the cursor’s slash-circle icon sprouts arrows 
pointing to the left and right, indicating that you are poised to mark the channel bad 
for the entire file. 

Once again, instead of marking any channels bad right now, you will use the Artifact 
Detection tool. 

10 Close the file.
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CHAPTER 10ARTIFACT DETECTION

n artifact detection, you automatically detect and mark bad channels and 
bad segments (which are segments that are contaminated by artifacts). 

The Artifact Detection specification editor consists of two main sections (see Figure 10-
1 on page 99).

• The first is the Threshold Artifact Detection Settings section, where you specify 
the parameters for detecting bad channels, eye movements, and/or eye blinks.

• The second is the Perform Inferences section, where you specify what inferences 
to make of the results produced by the Threshold Artifact Detection Settings 
section (e.g., whether to mark segments “bad” if they contain an eye movement 
or eye blink).

During operation, the Artifact Detection tool excludes:

• bad eye channels when detecting eye blinks and eye movements
• eye-blink segments when marking channels bad for the entire recording
• channels marked bad for the entire recording when marking bad segments

Threshold Artifact Detection Settings
In the Threshold Artifact Detection Settings section, the tool detects and marks bad 
channels and only detects eye blinks and eye movements.

To detect bad channels, eye blinks, or eye movement, the tool uses the data from each 
channel, eye-blink pair, or eye-movement pair, respectively. The tool can use either 
thresholds or moving averages (combined with thresholds) to detect artifacts.

I
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If you choose the threshold option, the tool:

• runs through the channels,
• takes the data from the user-specified window,
• subtracts the minimum microvolt value from the maximum value, and 
• compares the difference against the user-specified threshold in the Threshold 

Artifact Detection Settings section.

The moving-average option “smooths” the data to prevent any noisy sample from 
having too much influence in the algorithm. If you select this option, the tool 
performs the same steps as the threshold option, except it performs a moving average 
on the data before subtracting the minimum microvolt value from the maximum value.

Log File

After applying the Threshold Artifact Detection Settings to your data, you can view 
the artifact-detection results in a text-based log file output by the tool. 

The log file contains failure records listing the channel number, segment number (if 
applicable), settings to the parameters in the threshold specification, and offset into 
the segment (if applicable) in which the failure occurred.

Perform Inferences
The Perform Inferences section allows you to specify criteria for either segmented or 
continuous data. 

For segmented data, you can specify the criteria that will mark a segment bad because 
of bad channels, eye blinks, and eye movements. For continuous data, you can specify 
the criteria that will mark eye blinks and eye movements.

Eye Blinks or Eye Movements in Segmented or Continuous Data

To prevent bad eye channels from incorrectly influencing the marking of eye blinks or 
eye movements, the Perform Inferences section runs an algorithm that detects and 
discards segments or samples with bad eye channels and then runs through the 
remaining data, marking any threshold-violations as eye blinks or eye movements. 
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Bad Segments from Bad Channels

To prevent channels that are bad for the entire recording from being incorrectly 
marked as bad in a segment, the Perform Inferences section runs an algorithm that 
detects and discards these channels from the data. It sums up the number of bad 
channels per segment in the remaining data, and marks the segment or sample bad if 
it exceeds the threshold. 

There is an important relationship between the number of bad channels marked and 
the number of bad segments derived. Specifically, the more bad channels allowed in 
the “Mark channel bad in recording if bad for greater than X percent” option in the 
Perform Inferences section, the fewer bad segments you will have. 

The reason is that if a channel is borderline bad, and it is not marked bad for the entire 
recording, then the channel will be marked bad in many segments. Consequently, in 
those segments, there is an additional bad channel that could trigger the maximum-
number-of-bad-channels criterion. 

The default values for the Artifact Detection specification are typically sufficient. You 
will use them in this tutorial. (For more information about the artifact-detection 
algorithm, see Chapter 4, “Artifact Detection,” in the Net Station Waveform Tools 
Technical Manual.)

Create an Artifact Detection Specification

Editing the Specification
Before you can perform artifact detection on your recordings, you must create an 
Artifact Detection specification. 

1 If necessary, start Net Station and open the Waveform Tools window. 

2 Open an Artifact Detection specification editor and name the Artifact Detection 
specification “Artifact Detection”.
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3 In the Output Options panel, set the name field to Append “.log” and the 
destination field to Same As Source. The Output Options panel applies only to 
the Threshold Artifact Detection log file (see “Log File” on page 96). 

Note: The Artifact Detection tool does not create a new result file containing modified 
EEG data. It adds markings to an existing file. 

Setting the Tool-specific Parameters
In this tutorial, you will use the default settings for the tool-specific parameters. 

1 The Threshold Artifact Detection Settings section is blank. Click the “Add” 
button (the green "Plus” button to the right of the section) three times to 
populate the section with three panes. From the Operation pop-up menu in the 
panes, choose Bad Channels, Eye Blink, and Eye Movement (see Figure 10-1). 

The default values in the Threshold Artifact Detection Settings and Perform 
Inferences sections are sufficient for this tutorial. 

2 The Threshold Artifact Detection Settings and Perform Inferences sections 
contain checkboxes labeled “Overwrite all. . . .” If all these checkboxes are 
selected, then all prior threshold records, bad channel markers, and bad 
segment markers from previous artifact detection (whether created manually 
or with this tool) are cleared. This is useful if you ran the tool before and now 
want to run it with a different specification. 

By default, the “Overwrite” checkbox is selected in the Threshold Artifact 
Detection Settings section and unselected in the Perform Inferences section. 

3 If the “Output log file” checkbox at the bottom of the Threshold Artifact 
Detection Settings section is selected, a Threshold Artifact Detection log file is 
automatically generated after the tool is run (see “Log File” on page 96). By 
default, this checkbox is selected. 

4 The Restrict Search pane allows you to limit the amount of the segment that is 
checked for artifacts (which can be useful for long segments that may contain 
artifacts outside the range of interest). By default, the artifact search region is 
unrestricted. 
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Your Artifact Detection specification is now fully defined. Figure 10-1 shows the 
finished Artifact Detection specification. 

5 Close the Artifact Detection specification editor, saving the changes. 

Figure 10-1. A defined Artifact Detection specification

Threshold Artifact Detection Settings section Perform Inferences section

“Add” 
button
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Run the Artifact Detection Tool

In this section, you will run the Artifact Detection tool.

1 In the Waveform Tools window, add the ATD256_1.ses.40.sg file to the Inputs 
pane. There are several ways to add a file to the pane; see “Run the 
Segmentation Tool” on page 88 for a description of each method. 

2 Highlight the Artifact Detection specification in the Specifications pane of the 
Waveform Tools window, and click the Run button.

Remember that this operation does not output a new result file, but instead modifies 
the input file by adding markings. 

View the Results

In this section of the chapter, you will learn about Grid view and how to use 
Net Station Viewer and the File Info dialog to explore the results of your artifact 
detection. 

Introducing Grid View
1 Open the result file ATD256_1.ses.40.sg.

2 If necessary, choose View > as Categories, display the Navigation control strip, 
and set the time mode to Segment Time (Figure 10-2). 
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So far, you have used only Chart view of Net Station Viewer. Chart view is most 
similar to the view you have during acquisition. However, Net Station Viewer has 
four other views, each with different advantages. 

Grid view offers a useful way to look at bad channels because you can see all the 
channels at once, sorted by channel number. The bad channels stand out because their 
data look very different from the data in all the other channels. Channels marked bad 
(either manually or by the Artifact Detection tool) for the segment you are looking at 
are indicated in pink. 

3 Choose View > as Grid. 

Figure 10-2. The result file displayed in Chart view
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4 Choose Time > Fit Segment To Window, to allow you to see the entire segment 
without scrolling (Figure 10-3).

5 Randomly inspect some segments, noticing how the bad channels are colored 
to stand out in this view. 

6 Turn off the Fit Segment To Window setting. 

7 Return to Chart view by choosing View > as Chart, and return the time scaling 
to 60 mm/sec. 

Figure 10-3. The result file displayed in Grid view

Bad 
channel
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Using the File Info Dialog
The File Info dialog has some useful features for inspecting bad channels and bad 
segments. 

1 Choose Edit > File Info, to open the File Info dialog.

2 Click the Categories tab. 

3 In the View pop-up menu, choose Bad Channels. 

4 In the Mode pop-up menu, choose Count Segments for Which Channel is Bad. 

In the list that appears, you can see how many segments each channel is bad in. 
Notice that most channels are bad in none of the segments. A handful of channels are 
bad in 1–3% of the segments. Channel 51, which you saw was bad in Chapter 5, 
"Recognizing Noise,” is bad in 100% of the segments. It, therefore, is marked bad for 
the entire recording (Figure 10-4). 

5 In the Mode pop-up menu, choose List Bad Channels Per Segment. 

You now see a list, rather than a count, of the bad channels. 

Figure 10-4. Channel 51 is marked bad in the Categories pane of the File Info window
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Arrange your EEG display and File Info dialog horizontally as illustrated in
Figure 10-5.

The numbers (313/317) next to Standard Correct indicate that 313 out of 317 trials in 
this category are good. In other words, this category contains four bad segments. 
Similarly, you can see that the Target Correct category contains no bad segment. The 
table of segments is color-coded, with green representing good segments and pink 
representing bad segments. 

Figure 10-5. The EEG display (top) and File Info dialog (bottom)

Number of 
good segments/ 
total number of 
segments
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In the File Info window, scroll to Segment 15, which is colored pink in the Standard 
Correct category, indicating that it is bad. 

6 In the Viewer, use the Navigation control strip to navigate to segment 15 in the 
Standard Correct category (that is, choose Standard Correct in the Category 
selector and type 15 in the Segment selector). Notice the bad-segment icon 
( ) to the left of the Status button. 

7 Click the Status button to open the Segment Status palette. 

You can see that this segment was marked bad because a blink artifact was detected. 

8 If necessary, select the Events control-strip disclosure toggle to display the 
Events control strip. 

The User event track reveals that this is the period that you marked as a blink in 
Chapter 5, "Recognizing Noise.” (See Figure 10-6.)

Figure 10-6. Segment 15 contains the eye blink marked earlier

Stacking the windows 
allows you to find the bad 
segments in the 
Categories pane (bottom 
window) and to type in the 
segment number in the 
Segment selector in the 
Viewer (top window) so 
that you can go directly to 
that point in the data.
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 Figure 10-7 shows this segment using the Eyes montage. 

9 Navigate to the next bad segment, segment 61 in the Standard Correct category. 

This is also a blink artifact, as shown by the Segment Info panel and the data 
themselves.

If you want, you can inspect the remaining two bad segments, 122 and 223, in the 
Standard Correct category. They, too, are both blink artifacts. 

Note: You need not go through this process every time. You can simply run the tools and 
review the final results. You are examining a few steps along the way to learn how to 
confirm that the program is performing correctly and to learn more about using 
Net Station Viewer. 

10 Close the file. 

Figure 10-7. The Eyes montage in the Viewer allows an up-close view of the eye blink
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Additional Artifact Correction 
Techniques

This section of the chapter discusses some additional artifact correction techniques 
you can try. Detailed descriptions of these techniques are beyond the scope of this 
tutorial, but they are described briefly here. 

After averaging (discussed in Chapter 12), but before average referencing (discussed 
in Chapter 13), you can inspect the data for channels that do not look like their 
neighbors. The "View the Results” section in Chapter 11, "Bad Channel Replacement,” 
describes how to do this. If you find channels that do not look like their neighbors, 
they might be bad channels that the artifact-detection algorithm missed. 

If you find bad channels at this stage, you have several options: 

• In the averaged file, mark the channels bad for the entire file, and then run Bad 
Channel Replacement. If you do this, you must do so before average 
referencing. Otherwise, the bad channels will influence the average reference.

• In the segmented file, mark the channels bad for the entire file, and then redo 
Artifact Detection, followed by the remainder of the ERP derivation process.

• With the segmented file, redo Artifact Detection with different parameters to 
see if you get better bad channel detection. 
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CHAPTER 11BAD CHANNEL 
REPLACEMENT

n bad channel replacement, you replace the data in bad channels with data 
interpolated from the remaining channels. Bad channel replacement is based on the 

idea that because of electrical volume conduction, channels in proximity to each other 
will have similar data. This approximation increases in validity as channel count 
increases. For 128 or 256 channels, the results of bad channel replacement are quite 
good, but for channel counts less than 64, considerable and serious errors exist in the 
reconstructed data.

The bad channel replacement algorithm operates on good segments only. For each 
good segment, it replaces every sample of every channel that is bad for that segment 
with data interpolated from the remaining channels. It uses spherical splines as the 
interpolation method. 

Note: This implies that channels marked bad for the entire recording are replaced in every 
good segment, whereas channels marked bad for a subset of the segments are replaced only 
in the segments in which they are bad. 

Create a Bad Channel 
Replacement Specification

Before you can perform bad channel replacement on your recordings, you must create 
a Bad Channel Replacement specification.

1 If necessary, start Net Station and open the Waveform Tools window. 

2 Open a Bad Channel Replacement specification editor and name the Bad 
Channel Replacement specification “Bad Channel Replacement”
(see Figure 11-1).

I
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3 In the Output Options panel, set the name field to Append “.cr” (for channel 
replacement) and the destination field to Same As Source. 

Note: To prevent overly long filenames, this tutorial uses extensions that are shorter than 
the default extensions (e.g., “.cr” instead of “.bcr”).

The Bad Channel Replacement tool does not take any tool-specific parameters, so you 
are now finished defining your specification. 

4 Close the Bad Channel Replacement specification editor, saving the changes. 

Run the Bad Channel Replacement Tool

In this section, you will run the Bad Channel Replacement tool.

1 In the Waveform Tools window, add the ATD256_1.ses.40.sg file to the Inputs 
pane. There are several ways to add a file to the pane; if necessary, see “Run the 
Segmentation Tool” on page 88 for a description of each method. 

2 Highlight the Bad Channel Replacement specification in the Specifications pane 
of the Waveform Tools window, and click the Run button.

Figure 11-1. Bad Channel Replacement specification editor
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View the Results

In this section of the chapter, you will view the results of bad channel replacement on 
your data and learn about Topo Plot view. 

Introducing Topo Plot View
1 Open the pre-bad-channel-replacement file ATD256_1.ses.40.sg. 

2 If necessary, choose View > as Categories, display the Navigation control strip, 
set the time mode to Segment Time, and choose the default montage, Geodesic 
Sensor Net 256 2.0. 

Topo Plot view offers a useful way to look at bad channels because you can see all the 
channels at once, organized in a two-dimensional representation by location. The bad 
channels stand out because they do not resemble their neighbors. 

3 Choose View > as Topo Plot.

You now see a two-dimensional representation of the 
channel locations. You also have a new set of controls 
on the left side of the window. You will use those 
controls to optimize your view of the data (Figure 11-2). 

4 In the Plot Size panel, click Fit To Window. 

5 In the Layout panel, click Best Fit. 

6 In the Channel Size panel, click No Overlap 
(Max). 

7 In the Options panel, deselect every checkbox 
except Channel Numbers. 

8 From the menubar, choose Time > Fit Segment 
To Window. 

Figure 11-2. Topo Plot 
controls
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The Viewer should now look like Figure 11-3. Because some of these settings are a 
matter of personal preference, you may want to experiment with them. 

Inspecting Data in Topo Plot View
As you inspect the data by navigating to different segments and using different 
amplitude scales, you will notice the following: If you pick any handful of channels 
near each other, the waveforms in these channels tend to look very similar to each 
other. The one exception, as shown in Figure 11-3, is the bad channel, number 51. 

1 Inspect the data, as described earlier, to your satisfaction. 

Figure 11-3. Data in Topo Plot view before bad channel correction

Channel 51 
is bad but 
has not been 
replaced yet
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Now compare this with the post-bad-channel-replacement file. 

2 Open the result file ATD256_1.ses.40.sg.cr.

3 Set up the Viewer as you did for the previous file (as Categories, fit segment 
time to window, and so forth; Steps 2–8 on page 111). 

4 Inspect the data, and notice that the waveforms of channel 51 now look like 
their neighbors. 

5 Close both files. 

Figure 11-4. Data in Topo Plot view after bad channel correction

Channel 51 
has been 
replaced
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CHAPTER 12AVERAGING

n averaging, you calculate a single, average segment from all the segments that 
were not rejected, for each category you created during segmentation.

Create an Averaging Specification

Editing the Specification
Before you can perform averaging on your recordings, you must create an Averaging 
specification. 

1 If necessary, start Net Station and open the Waveform Tools window. 

2 Open an Averaging specification editor and name the Averaging specification 
“Average”.

3 In the Output Options panel, set the name field to Append “.av” (for averaging) 
and the destination field to Same As Source. 

Note: To prevent overly long filenames, this tutorial uses extensions that are shorter than 
the default extensions (e.g., “.av” instead of “.ave”).

I
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Setting the Tool-specific Parameters
Now, set the tool-specific parameters. 

1 In the Handle Source Files panel, click the Separately button.

2 In the Handle Subjects panel, click the Separately button. 

3 Click the Copy Events from First File (Slower) radio button.

Your Averaging specification is now fully defined. Figure 12-1 shows the finished 
Averaging specification. 

4 Close the Averaging specification editor, saving the changes.

Figure 12-1. Averaging specification editor
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Run the Averaging Tool

In this section, you will run the Averaging tool.

1 In the Waveform Tools window, add the ATD256_1.ses.40.sg.cr file to the Inputs 
pane. There are several ways to add a file to the pane; if necessary, see “Run the 
Segmentation Tool” on page 88 for a description of each method. 

2 Highlight the Average specification in the Specifications pane of the Waveform 
Tools window, and click the Run button.

View the Results

In this section of the chapter, you will learn how to navigate an averaged Net Station 
file and begin learning about the effects of referencing. 

1 Open the result file ATD256_1.ses.40.sg.cr.av. 

2 If necessary, choose View > as Categories, choose View > as Topo Plot, display 
the Navigation control strip, and set the time mode to Segment Time. 

3 Select each category, and note that now there is only one segment in each 
category, named “Average: subj01” (Figure 12-2)
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For each category, the one segment is the average of all the segments for that category. 

If your amplitude scaling is set as it had been before averaging, your waveforms will 
seem very flat (see Figure 12-2). This is because the averaging operation reduces 

Figure 12-2. Averaged data with one segment per category
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amplitudes. Unprocessed, artifact-free EEG typically has ranges from –40 to 40 µV, 
whereas averaged EEG typically has ranges from –5 to 5 µV. 

4 In the Amplitude Scale panel of the Scale control strip, set the scaling to
1 µV/mm (Figure 12-3).

The waveforms now show some shape. Notice that the amplitudes are greatest 
around the edges and are almost flat toward the center. This is because the data were 
recorded using the vertex as the reference. The reference channel, by definition, has 
values of zero. So, the closer the channels are to the reference channel, the flatter the 
waveforms. 

Figure 12-3. Averaged data with amplitude scale set at 1 µV/mm

before changing 
the amplitude

after changing 
the amplitude to 
1 µV/mm
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In the next chapter, you will perform an average referencing operation on the data. In 
the Viewer, you can preview the results of average referencing by using the Average 
Reference montage. 

5 Choose Average Reference from the Montage pop-up menu above the data-
display area (Figure 12-4). 

Notice the effect this has on the data display—the amplitudes are more evenly 
distributed among all the channels. This montage affects the display only. It does not 
change your data.

6 Close the file. 

Figure 12-4. Averaged data with average reference montage applied

Apply the 
average 
reference 
montage
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chapter 13

CHAPTER 13AVERAGE 
REFERENCING   

n average referencing, you rereference the data to an average reference corrected for 
the polar average reference effect (PARE). What follows is a discussion of issues 

related to rereferencing and PARE-corrected average referencing.

EEG is a measure of voltage, and voltage measurements are inherently differential. In 
other words, any voltage measurement is really a measurement of the difference in 
potential between the site being measured and a reference site that is assumed to have 
a value of zero. In actuality, any choice of reference is arbitrary. There is no site that 
can be assumed to have a value of zero, and, to make matters worse, there is no site 
that can even be assumed to have an constant value from one timepoint to the next. 

The objective of rereferencing EEG data is to estimate a true, nonarbitrary zero value 
to which to reference the voltage measurements. There are several reasons to believe 
that, at any given time, the average over every point on the surface of the body (i.e., 
the surface integral) would represent such an ideal reference value: 

• If you assume, as many researchers do, that neural sources are dipolar (at 
practical distances from the sources), then positive and negative fields will sum 
to zero. Regardless of how many sources are active, if the entire surface of the 
volume is measured, assuming homogeneous conductivity, the surface integral 
will therefore be zero.

• Even if you do not make the preceding assumption, because of conservation of 
charge inside an electrically neutral body, the surface integral will be zero.

As channel counts increase, the average of all the channels better approximates the 
surface integral and, therefore, the ideal zero reference value. To eliminate the 
influence of the arbitrary recording reference channel and use instead a reference that 
approximates the ideal zero reference, many researchers prefer to rereference their 
data to the average reference.

However, if the head surface is unevenly sampled, then the average reference is biased 
toward the region that is sampled. This is known as the polar average reference effect 

I
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or PARE. For example, if the electrodes are concentrated on the top of the head, and 
inadequately sampled on the undersurface, then the average reference is biased 
toward the top of the head. Even with EGI's dense-array Geodesic Sensor Nets, the 
entire head surface cannot be adequately sampled (e.g., the underside is still not 
sampled). Therefore, there will always be a PARE when using the average reference. 

One solution to this problem is to use a PARE-corrected average reference. The PARE-
corrected average reference is computed from the entire surface of the head, including 
the surface not covered by electrodes. Spherical spline interpolation is used to 
estimate the voltages of the surface that is not covered. For more information on 
PARE, see the following:

• Junghoefer, M., Elbert, T., Tucker, D. M., & Braun, C. (1999). “The Polar Average 
Referenced Effect: A Bias in Estimating the Head Surface Integral in EEG 
Recording.” Electroencephalography and Clinical Neurophysiology, 98, 422–434.

Create a Montage Operations 
Specification

Editing the Specification
Average referencing is performed with the Montage Operations tool. Before you can 
perform average referencing, you must create a Montage Operations specification.

1 If necessary, start Net Station and open the Waveform Tools window. 

2 Open a Montage Operations specification editor and name the Montage 
Operations specification “PARE”.

3 In the Output Options panel, set the name field to Append “.ar” (for average 
reference) and the destination field to Same As Source. 

Note: To prevent overly long filenames, this tutorial uses extensions that are shorter than 
the default extensions (e.g., “.ar instead of “.sub”).
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Setting the Tool-specific Parameters
Setting the Montage Operations–specific parameters consists of selecting a montage, 
creating it first if necessary, and, for average referenced montages, indicating whether 
you want the reference PARE corrected (Figure 13-1). 

1 From the Source Net pop-up menu, choose Geodesic Sensor Net 256 2.1. 

A list of montages for this Net appears. 

2 Select the Average Reference montage. 

3 Select the Perform PARE Correction checkbox at the lower left of the editor. 

Figure 13-1. Montage Operations specification editor
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4 Below that checkbox, deselect the Exclude Bad Channels from Reference 
checkbox.

Your Montage Operations specification is now fully defined. Figure 13-1 shows the 
finished Montage Operations specification. 

5 Close the Montage Operations specification editor, saving the changes. 

Run the Montage Operations Tool

In this section, you will run the Montage Operations tool.

1 In the Waveform Tools window, add the ATD256_1.ses.40.sg.cr.av file to the 
Inputs pane. There are several ways to add a file to the pane; if necessary, see 
“Run the Segmentation Tool” on page 88 for a description of each method. 

2 Highlight the PARE specification in the Specifications pane of the Waveform 
Tools window, and click the Run button.

View the Results

1 Open the result file ATD256_1.ses.40.sg.cr.av.ar.

2 If necessary, configure the Viewer as it had been in the previous chapter (as 
categories, as Topo Plot, in Segment Time). 



Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

13: Average Referencing

125

Notice the effect of the referencing on the data (Figure 13-2). 

3 Close the file. 

Figure 13-2. The PARE-corrected file ATD256_1.ses.40.sg.cr.av.ar



Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

13: Average Referencing

126



127Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

chapter 14

CHAPTER 14BASELINE 
CORRECTION   

n baseline correction, you establish a baseline interval within your segment. You 
select the interval to use as the baseline. For stimulus events, the baseline interval 

normally precedes the stimulus. For each channel, the average of all the samples 
within the baseline interval is subtracted from every sample in the segment. This 
baseline value establishes a new zero-voltage value. 

Create a Baseline Correction 
Specification

Editing the Specification
Before you can perform baseline correction on your recordings, you must create a 
Baseline Correction specification. 

1 If necessary, start Net Station and open the Waveform Tools window. 

2 Open a Baseline Correction specification editor and name the Baseline 
Correction specification “Baseline –100 to 0”.

3 In the Output Options panel, set the name field to Append “.bc” (for baseline 
correction) and the destination field to Same As Source. 

Note: To prevent overly long filenames, this tutorial uses extensions that are shorter than 
the default extensions (e.g., “.bc instead of “.blc”).

I
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Setting the Tool-specific Parameters

 

Now, set the tool-specific parameters. 

 

1

 

From the Select Baseline From pop-up menu, choose Portion of Segment. 

 

2

 

From the Select Baseline With Respect To pop-up menu, choose Segment 
Time= 0. 

 

3

 

Use the input boxes to specify that the “baseline begins 100 ms before sample 
and is 100 ms long”. 

Your Baseline Correction specification is now fully defined. Figure 14-1 shows the 
finished Baseline Correction specification. 

 

4

 

Close the Baseline Correction specification editor, saving the changes.

 

Run the Baseline Correction Tool

 

In this section, you will run the Baseline Correction tool.

 

1

 

In the Waveform Tools window, add the ATD256_1.ses.40.sg.cr.av.ar file to the 
Inputs pane. There are several ways to add a file to the pane; if necessary, see 
“Run the Segmentation Tool” on page 88 for a description of each method. 

 

2

 

Highlight the Baseline -100 to 0 specification in the Specifications pane of the 
Waveform Tools window, and click the Run button.

 

Figure 14-1. 

 

Baseline Correction specification editor



Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

14: Baseline Correction

129

View the Results

In this section of the chapter, you will view the results of baseline correction on your 
data and learn about the Butterfly montage. 

Introducing the Butterfly Montage
1 Open the pre-baseline-correction file ATD256_1.ses.40.sg.cr.av.ar. 

2 If necessary, choose View > as Categories, display the Scale and Navigation 
control strips, and set the time mode to Segment Time. 

3 Switch to Chart View by choosing View > as Chart. 

The Butterfly montage shows all the channels overlaid on each other. It is a good view 
for checking baseline correction, looking for bad channels, and finding peaks of 
activity. 

4 Choose Butterfly from the Montage pop-up menu above the data-display area. 

Immediately above the channel tiles, to the left, is a 
series of three buttons (see Figure 14-2). 

These buttons control the height of each channel tile. 
The rightmost of these three buttons expands the 
channel tile to fill the available vertical space. 

5 Click the rightmost of these three buttons. 

6 In the Scale control strip, click the Time-Scale Fit button, which expands the 
waveforms horizontally to fill the available space. 

7 In the Scale control strip, set the amplitude scale to 0.4 µV/mm. 

Comparing Files
1 From the Navigation control strip, click the category selector and choose 

Standard Correct. 

2 Open the result file ATD256_1.ses.40.sg.cr.av.ar.bc.

Figure 14-2. Channel-
height buttons

Expands channel to fit vertically
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3 Set up the Viewer as you did for the previous file (see Steps 2–7 on page 129). 

Figure 14-3 shows the Standard Correct category, both before and after baseline 
correction. 

Compare the baseline-corrected data with the pre-baseline-corrected data. Notice that 
in the baseline epoch (–100 to 0), the baseline-corrected data are smaller in amplitude. 
Compare the two files in the Target Correct category as well. 

4 Close both files. 

Figure 14-3. The Standard Correct category before baseline correction (top) and after (bottom)
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chapter 15

CHAPTER 15SCRIPTING

nce you are satisfied with your data-analysis path (i.e., which tools to use, in 
which order, with which parameters), you can automate your data analysis with 

scripting. Scripting is done with the Script tool, a special device for automating your 
ERP derivation by chaining tool operations together. Script is similar to the other tools 
in that you use the Waveform Tools window to launch a Script specification editor and 
to run the script. 

Create a Script Specification

Before you can process your data with a script, you must create a Script specification.

1 If necessary, start Net Station and open the Waveform Tools window. 

2 Open a Script specification editor and name the Script specification “ATD 
Script”.

The Script specification editor has no Output Options panel. This is because, as you 
will see, the output options are set separately for each tool in the script. 

3 Place the ATD Script specification editor next to the Waveform Tools window, 
and simply drag the following tool specifications (created in the previous 
chapters) from the Waveform Tools window to the Script Settings panel (see 
Figure 15-1) of the Script specification editor in this order: 

• Lowpass 40 Hz
• ATD Seg
• Artifact Detection

O
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• Bad Channel Replacement
• Average
• PARE 

Note: This list does not include the Baseline –100 to 0 specification. You will perform this 
operation in the next chapter. 

Each item in the script has a Keep Output File option. You can save disk space by 
saving only the data files of interest. For now, the only file you need is the output of 
the final average referencing operation. 

Figure 15-1. Drag tools to the Script Settings pane to create a script
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4

 

Deselect the Keep Output File checkboxes so that only the output of the final 
average referencing operation is kept. Figure 15-2 shows the completed 
specification. 

 

5

 

Close the Script specification editor, saving the changes. 

 

Figure 15-2. 

 

Script specification editor

Filtering specification 
from Chapter 8

Segmentation 
specification from 
Chapter 9

Artifact Detection 
specification from 
Chapter 10

Bad Channel 
Replacement 
specification from 
Chapter 11

Averaging 
specification from 
Chapter 12

Rereferencing 
specification from 
Chapter 13
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Run the ATD Script

1 There are three files you have not processed yet: 

• ATD256_2.ses
• ATD256_3.ses
• ATD256_4.ses

Place all three files in the Inputs list of the Waveform Tools window using one 
of two methods:

° Click the Add button in the Waveform Tools window, navigate to the files, 
and select them by Shift-clicking.

° Shift-click on the file icons to select them all and drag them from the Finder 
into the Inputs pane of the Waveform Tools window.

2 Highlight the ATD Script specification in the Specifications pane, and click the 
Run button.

Note: Depending on your computer resources, running the script on these three files may 
require as much as two hours.

View the Results

In this section of the chapter, you will learn how to view the history of your data-
analysis path, which is stored in a Net Station recording. 

Note that there is now an average-referenced averaged file for each subject: 

• ATD256_2.ses.40.sg.cr.av.ar
• ATD256_3.ses.40.sg.cr.av.ar
• ATD256_4.ses.40.sg.cr.av.ar

1 Open the result file ATD256_2.ses.40.sg.cr.av.ar. 

2 Choose Edit > File Info. 

The File Info dialog appears, displaying its six tabs. 
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3 Click the History tab. 

4 Click the Collapse All button. 

The History pane contains an item for each operation performed on the data through 
the creation of this file. Each item has a disclosure triangle for displaying more 
information about the corresponding operation. 

5 Click on the disclosure triangle for the Segmentation item. If the Timestamp, 
Inputs, Settings, and Results sections for the Segmentation item are not 
displayed, then click the correspondingly named toggles at the top left of the 
window to reveal this information (Figure 15-4). To hide any of these sections, 
click on their corresponding toggles. 

Figure 15-3. History pane

Tool disclosure 
triangles
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Notice that in the Results section of the History pane you can see how many segments 
there are in the Standard Correct and Target Correct categories. 

6 Click the Segmentation disclosure triangle to close that section, and click on the 
Artifact Detection disclosure triangle to view its Results section.

Figure 15-4. History pane: Segmentation

Hide/display toggles 
for information 
about the tools

Number of 
segments 
produced
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Notice that you can see how many segments were marked bad. 

 

Figure 15-5. 

 

History pane: Artifact Detection

Number of 
segments 
marked “bad”
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If you want, you can view the history of the other operations. You can view the 
history of the other result files as well. 

7 Close the file(s). 
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chapter 16

CHAPTER 16COMBINE AND 
GRAND AVERAGING

n grand averaging, you average all the individual-subject ERPs to create a cross-
subject ERP. Grand averaging emphasizes the ERP patterns shared by all the 

subjects and deemphasizes individual differences. You should use non-baseline-
corrected data for grand averaging so that you can understand the effects of baseline 
correction on your grand-average ERPs. 

Grand averaging is done with the Averaging tool (the same tool you used for single-
subject averaging). Before you can perform grand averaging on your data, you must 
create an Averaging specification. 

In this chapter, you will actually do a little more than grand averaging. You will create 
and run a script that performs the following three tasks: 

• combines all the individual-subject average files into a single file that has the 
average ERPs for all subjects

• creates a file with a grand-average ERP
• creates a file with a baseline-corrected grand-average ERP

Note: Combining files before grand averaging allows you to view individual subject EEG 
data in one grand-average file for direct comparison between subjects. The resulting file is 
also useful for checking which subjects contributed to the grand-average ERP, if some 
subjects had to be omitted from the grand averaging. 

You will also run the baseline correction operation on the file that contains the average 
ERPs for all subjects. 

I
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Before you can do this, you will need to:

• create a Combine Files specification
• create an Averaging specification for grand averaging
• create a Script specification that includes the preceding two items as well as a 

Baseline Correction specification

Create a Combine Files Specification

Editing the Specification
1 Start Net Station and open the Waveform Tools window, if necessary.

2 Open a Combine Files specification editor and name the Combine Files 
specification “Combine”. 

3 In the Output Options panel, set the name field to “ATD256.av”, using the 
Fixed command from the Name menu. Set the destination field to Same As 
Source. 

Setting the Tool-specific Parameters
Now, set the tool-specific parameters. 

1 From the Combine Files By pop-up menu, choose Merging Files. 

Leave all checkboxes unselected. Your Combine Files specification is now fully 
defined (Figure 16-1). 
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2 Close the Combine Files specification editor, saving the changes. 

Create an Averaging Specification

Edit the Specification
1 Open an Averaging specification editor and name the Averaging specification 

“Grand Average” (see Figure 16-2).

2 In the Output Options panel, set the name field to Append “.ga” (for grand 
averaging) and the destination field to Same As Source. 

Set the Tool-specific Parameters
Now, set the tool-specific parameters. 

1 In the Handle Source Files panel, click the Together button. 

2 In the Handle Subjects panel, click the Together button. 

Figure 16-1. Combine Files specification editor
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3 Click the Copy Events From First File (Slower) radio button (Figure 16-2). 

Your Averaging specification is now fully defined.

4 Close the Averaging specification editor, saving the changes. 

Create a Script Specification

1 Open a Script specification editor and name the Script specification “ATD II 
Script”.

2 Drag the following tool specifications from the Waveform Tools window to the 
Script Settings panel of the Script specification editor in this order: 

• Combine
• Grand Average
• Baseline –100 to 0

Figure 16-2. Grand Averaging editor
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3 Make sure that all three items have their Keep Output File checkboxes selected 
(Figure 16-3).

4 Close the Script specification editor, saving the changes. 

Run the ATD II Script 

1 Place the following files in the Inputs pane of the Waveform Tools window by 
clicking the Add button and navigating to each file in numerical order, or by 
dragging each file into the pane in numerical order (for the purposes of this 
tutorial, the files MUST be individually added to the Input pane in the following 
numerical order; do NOT select them using Option-click):

• ATD256_1.ses.40.sg.cr.av.ar
• ATD256_2.ses.40.sg.cr.av.ar
• ATD256_3.ses.40.sg.cr.av.ar
• ATD256_4.ses.40.sg.cr.av.ar

Figure 16-3. ATD II Script specification
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Note: In this example, we are using all of the subjects. You might choose to omit a subject 
for various reasons, such as noisy data or poor behavioral results (e.g., too many 
incorrects).

2 Highlight the ATD II Script specification in the Specifications pane, and click 
the Run button. 

Run Baseline Correction on a Result File

To have a baseline-corrected copy of the combined file, run the Baseline Correction 
tool on ATD256.av, one of the files produced with the ATD II Script in the preceding 
section.

1 In the Waveform Tools window, add the ATD256.av file to the Inputs pane. 
There are several ways to add a file to the pane; see “Run the Segmentation 
Tool” on page 88 for a description of each method. 

2 Highlight the Baseline -100 to 0 specification in the Specifications pane of the 
Waveform Tools window, and click the Run button.

View the Results

Section IV, “Exploring ERPs,” is devoted to the lengthy topic of viewing and 
analyzing your grand-average ERPs. For now, you will learn how to navigate a 
multisubject average file. 

1 Open the baseline-corrected multisubject averaged file ATD256.av.bc. 

2 If necessary, choose View > as Categories, View > As Topo Plot, and Montage 
> GSN 200 256 2.0 Average Reference 1.0. 
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3

 

Select each category and note that there is one segment in each category for 
each subject, and that all the subjects who contributed to the grand average are 
listed (Figure 16-4).     

 

4

 

Close the file.

 

Figure 16-4. 

 

A multisubject average file, in “as Categories” mode
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SECTION IV: 
EXPLORING ERPS
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chapter 17

CHAPTER 17VISUALIZING ERPS

n this section, you will learn how to explore and compare the ERPs of the two 
conditions using Topo Plot view, which you have already learned about, and the 

interpolated Topo Map view, which is introduced in this chapter. 

1 Open the baseline-corrected grand-average file ATD256.av.ga.bc. 

2 If necessary, set up a Topo Plot view as you did in “Introducing Topo Plot View” 
on page 111. 

3 Set the amplitude scaling to 1 µV/mm.

Overlaid Segments in Topo Plot View

The “as Overlaid Segments” viewing option is useful for comparing different 
conditions. 

1 Choose View > as Overlaid Segments.

Each channel now shows the waveforms for both conditions superimposed 
(Figure 17-1). The waveforms are color-coded.

I
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Also, the Overlaid Segments palette 
appears (Figure 17-2). 

This palette allows you to control how 
the overlaid segments are displayed. If 
you have more than two conditions, you 
can use this window to choose which 
conditions to include in the overlay. By 
clicking on the color control (the blue or 
red rectangle) for a given condition, you 
can use a variety of sophisticated 
methods for selecting the color for that 
condition. 

Figure 17-1. View “as Overlaid Segments”

Figure 17-2. Overlaid Segments palette
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Note: The order of the segments in the Overlaid Segments palette dictates the order in 
which the segments are drawn in the Viewer. In general, the segments are drawn from 
bottom to top, with the bottom segment serving as the grid (thus, in Figure 17-2, Target 
Correct would form the first layer). The next segment to be drawn in the Viewer is the one 
above the bottom segment in the Overlaid Segments palette and so on. Chapter 3, 
“Common Viewer Window Elements,” in the Net Station Viewer Technical Manual 
discusses this in more detail.

2 Experiment with changing the colors of the waveforms. 

If you dismiss the Overlaid Segments palette, you can display it again by clicking on 
the button in the lower left of the Navigation control strip.

You can select a specific channel and zoom-in on it. To do this, double-click on the 
channel, which activates the Channel Zoom mode. 

3 Double-click on channel 8 in the Topo Plot displayed in the Viewer. 

Channel 8 appears by itself and displayed with triple the amplitude, for easier 
viewing. You can scale it to meet your needs. In Channel Zoom mode, the 1:1 time 
scaling is good because it eliminates aliasing. This is because with this scaling, there is 
one pixel for each sample. 

4 From the Time menu, choose Actual Size (1:1).

With channel 8 zoomed (Figure 17-3), you can easily see the increased positivity in the 
Target Correct, compared with the Standard Correct condition, at around 350 ms. This 
increased positivity in the target is what is known as the P300. You can also see the 
negativity in both conditions at around 120 ms. This is the auditory N100. 

Overlay button



152

17: Visualizing ERPs

Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

Interpolated Topo Map View

Topo Map view displays samples as disks that represent, in two dimensions, the 
topography of the entire head. Amplitudes are represented using color over the entire 
surface of the head, with interpolation used to calculate the amplitudes between the 
sensors. This view is useful for creating animations of ERP data. 

Topo maps are accompanied by amplitude scales that allow you to tell, based on the 
color, the approximate voltage value of different points on the map. An amplitude 
scale is defined by a color spectrum and the amplitude range it represents. The 
maximum voltage value of the amplitude-scale range is associated with the high end 
of the spectrum, and the minimum value is associated with the low end. 

Figure 17-3. Zooming in on a channel
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Topo Map view offers features for very fine control over many aspects of the 
appearance of your topo maps. This tutorial covers several of the most basic and 
important of these features. You will view the data “as Topo Map” in a new window. 
Later you will use the current window, in Channel Zoom mode, in conjunction with 
the Topo Map window and the linked-window feature you learned about in 
Chapter 5, "Recognizing Noise.” 

1 Choose View > Open New Window.

A second window appears in Topo Plot view. The new window is exactly like the 
original, except that Channel Zoom is closed and all channels are displayed. Keep the 
first window in the background for use later in this chapter.

2 With the new window in the foreground, choose View > as Topo Map. 

Topo Map view appears. Because you are still viewing “as Overlaid Segments,” there 
are two topo maps, one for each condition (Figure 17-4). 

Note: Your screen may appear slightly different, depending on your system’s settings and 
history.

Figure 17-4. Topo Map view

Amplitude 
Scale palette
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Next, you will set up the amplitude 
scale using the Amplitude Scale 
palette (Figure 17-5), which is on the 
left side of the Viewer window. 

The Amplitude Scale palette offers 
many tools. The following are brief 
descriptions of the numbered items 
from Figure 17-5. 

1.  Spectrum pop-up menu. Allows 
selection of the color spectrum.

2.  Palette-maximum label. Indicates 
the current palette maximum. 

3.  Palette-maximum slider. When 
dragged, this changes the palette 
maximum.

4.  Histogram. Displays the 
distribution of voltage values in the 
sub-epoch chosen using the sub-
epoch pop-up menu (12). Rolling the 
cursor over the histogram causes a 
popup to appear containing the 
range of voltage values for the 
histogram bin under the cursor, and 
the number of samples in the bin. 

5.  Palette-minimum slider. When 
dragged, this changes the palette 
minimum.

6.  Palette-minimum label. Indicates 
the current palette minimum.

7.  Histogram minimum label. 
Indicates the minimum value in the 
histogram (the smallest data value in 
the sub-epoch on which the 
histogram is based). 

1

2

4

3

5

6 7

8

9

10

11

12

Figure 17-5. Amplitude Scale palette
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8.  Statistics bar. Contains different colored sections. The top and bottom red portions 
represent the maximum and minimum 2.3% of the voltage values, respectively. The 
top and bottom yellow portions represent the next maximum and minimum 13.7% of 
the voltage values, respectively. 

9.  Lock toggle. When depressed, this forces the histogram (3) to fill the histogram 
area. 

10.  Histogram maximum label. Indicates the maximum value in the histogram 
(i.e., the largest data value in the sub-epoch on which the histogram is based). 

11.  Statistics-bar toggle. Toggles the display of the statistics bar (8). 

12.   Sub-epoch pop-up menu (one for each histogram displayed). Allows you to select 
the sub-epoch on which the underlying histogram (3) is based. 

Now, you can continue setting up the amplitude scale. 

3 Choose Seismic from the Spectrum pop-up menu. 

Use the amplitude-range tools to select an optimal amplitude-scale range. 

4 Choose the Segment icon from the sub-epoch pop-up menu to 
use the entire segment as the sample range for the histogram 
(Figure 17-6).

The histogram now references the entire segment. 

5 Select the Lock toggle to force the histogram to fill the histogram area. 

6 Select the statistics-bar toggle to display the statistics bar. 

You now have a good statistical description of the data in the sample range. You know 
the maximum and minimum voltage values (that is, histogram minimum and 
maximum) and have a graphic representation of the distribution and standard 
deviation information. 

You can use this information to select an optimal amplitude-scale range. You could do 
this by using the palette maximum and minimum sliders. However, there is an easier 
way. 

7 Click in the yellow area of the statistics bar. 

Figure 17-6.  
Segment icon
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This forces the amplitude-scale range to exactly span 95% of the data (or all values 
within two standard deviations from the mean, assuming the values have a normal 
distribution). This is preferable to having the amplitude-scale range span 100% of the 
data because in that case, the outliers have too much influence on the amplitude scale.

8 Navigate to 371 ms. 

You now have a different way of looking at the increased positivity in the Target 
Condition, known as the P300 (Figure 17-7). 

The remainder of this chapter describe three different ways to use Topo Map view to 
see how ERP evolves over time. 

Figure 17-7. Topo Map P300
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Watching ERPs Evolve over Time with Animation
One way to see how an ERP evolves over time is to use the 
animated scrolling buttons of the Navigation control strip
(Figure 17-8). 

1 Navigate to the beginning of the segment, using the 
Navigation control-strip slider. 

2 Click one of the animated scrolling buttons. 

Watching ERPs Evolve over Time with Layout

Another way to see how an ERP evolves over time is to change the layout to show 
multiple samples simultaneously. 

1 Navigate to the beginning of the segment, using the Navigation control-strip 
slider. 

2 If necessary, click the disclosure triangle by the Options label to display the 
Options panel. 

3 Click the Layout button of the Options panel. 

The Layout dialog appears (Figure 17-9). 

Figure 17-9. Map Layout and Size window

Figure 17-8. 
Animated 

scrolling buttons
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4 Set Map Layout to Grid (4 Rows). 

5 Set Interpolation Density to Fit To Map Size. 

6 Set Map Size to Fit To Window. 

7 Click OK. 

You now see 12 samples simultaneously (Figure 17-10).

Note that time progresses from top to bottom, and then from left to right. In other 
words, the first sample is in the upper left; the second sample is the one immediately 
underneath the first; the fifth sample is in the upper center; and so on. 

Figure 17-10. Multisample view
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You now see an epoch spanning –101 ms to –57 ms. To see a bigger epoch at one time, 
you can choose to skip samples between maps. Note that the Time Scale panel of the 
Scale control strip is different in Topo Map View. In this view, you choose samples/
map. 

8 Use the Time Scale panel to select 10 samples/map. 

9 Drag the slider of the Navigation control strip to the far right. 

You now see an epoch spanning 19 ms to 459 ms (Figure 17-11). 

Figure 17-11. Multisample view with 10 samples/map
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Watching ERPs Evolve over Time with Time Synch

Another way to see how an ERP evolves over time is to use the Time Synch and the 
Link feature you learned about in Chapter 5, "Recognizing Noise.” This method is 
useful for locating an area of interest in a single channel and then viewing the 
topography of that timepoint over the entire head. You will use the current Topo Map 
view window and the Topo Plot view window that you set aside at the beginning of 
this chapter.

1 Return the Topo Map view time scale to 1 sample/map with the Time Scale 
panel, and return the layout to Single Map with the Layout dialog.

2 Select the Link button (located in the top-right corner of the Viewer window) in 
both the Topo Map view and Topo Plot view windows.

3 Select the Time Synch toggle (located on the data-display control strip) in both 
windows. 

You have now linked the two windows in time, so that the data sample underlying 
the Time Synch in Topo Plot view is the same as that which is displayed in Topo Map 
view. 

In Topo Plot view, the Time Synch is a line, brown by default. You can change the 
color using the Viewer Preferences dialog. In Topo Map view, the Time Synch is a 
frame around the appropriate map. 

As you navigate temporally through the Topo Plot window by dragging the Time 
Synch or by using the navigation controls in the Topo Map window, all other linked 
windows are automatically updated.

In the following steps, you will drag the Time Synch to a specific timepoint. To assist 
in navigating to a precise timepoint, you can use tools on the status bar. The status bar 
contains a timepoint indicator. The contents of the timepoint indicator depends on the 
state of the two toggle buttons to the left of the status bar (Figure 17-12). 

Link button

Time Synch toggle
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The button on the left is the sample/millisecond toggle. Depending on the state of this 
toggle, information in the timepoint indicator will be expressed in either samples or 
milliseconds. The  icon indicates samples mode, and the  icon indicates 
milliseconds mode. The default mode is milliseconds mode, the mode you will use in 
this chapter. 

The button on the right is the selection/roll-over/Time Synch toggle. Depending on 
the state of this toggle, information in the timepoint indicator will be about either the 
current selection, the sample under the cursor, or the sample under the Time Synch 
marker. The  icon indicates selection mode, the  icon indicates roll-
over mode, and the  icon indicates Time Synch mode. The default mode is roll-
over mode. You will use the Time Synch mode in this chapter. 

 

4

 

In the Topo Plot view window, set the sample/millisecond toggle to 
milliseconds mode, and the selection/roll-over/Time Synch toggle to Time 
Synch mode. 

 

5

 

In the Topo Plot view window, drag the Time Synch to 371 ms, which you 
earlier determined was the location of the P300. The Topo Map view window 
will update to display the map for the same sample.

 

6

 

For easier side-by-side comparison, click the Minimize button (located on the 
far-right of the data-display control strip) in both windows. 

The Minimize mode hides all Viewer controls and displays only the graph, 
chart, or map of interest. Only the title bar and a Restore button (on the right 

 

Figure 17-12. 

 

Status bar

Status bar in sample and selection mode

Status bar in millisecond and roll-over mode

sample selection

millisecond roll-over

Status bar in millisecond and Time Synch mode

millisecond Time Synch

Minimize button

Restore button
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side of the status bar) are displayed with the graphic. Click the Restore button 
to return the window to its normal state, with the Viewer controls displayed.

Figure 17-13 shows both windows in Minimize mode with the Time Synch at 371 ms. 
Note the different appearance of the Time Synch in the two views. 

Figure 17-13. The P300 viewed using the Time Synch feature

Time Synch
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7 In the Topo Plot view window, drag the Time Synch to 123 ms to view the 
topography of the N100 in the Topo Map view window. 

8 Close both files.
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chapter 18

CHAPTER 18EXTRACTING DATA FOR 
STATISTICAL ANALYSIS

his tutorial has taken you through the processing steps required to derive the ERP. 
In Chapter 17, "Visualizing ERPs,” you were able to view the results of these steps, 

identify several ERP components (the N100 and P300), and visually inspect the ERP 
components for differences as a function of the experimental conditions. The next step 
is to determine whether a particular component is statistically different between 
experimental conditions. 

In this chapter, you will create a text file suitable for importing into a statistical 
software package (such as SPSS or JMP) to show statistically that the P300 component 
is larger in amplitude for the target condition than it is for the standard. The text file is 
generated by the Statistic Extraction tool, which is a Waveform Tool that generates a 
text file, rather than a Net Station data file. Before you can use the Statistic Extraction 
tool, you must create events and a montage that specifies the time window and 
channel group for the statistics. 

To extract data for statistical analysis, you will perform the following tasks:

• select time windows for the extraction of statistics
• create a user event track
• create a user event set and user events
• insert user events that span the selected time windows
• create a montage to verify the time windows for the individual subjects
• verify the time windows for the individual subjects
• create a Statistic Extraction specification
• run the Statistic Extraction tool
• view the results

T
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Select Time Windows for the 
Extraction of Statistics

Before defining the window for statistic extraction, you must have a general idea of 
where you should place each ERP window. To do this, it is best to inspect the grand-
average file.

1 Open the baseline-corrected, grand-average file ATD256.av.ga.bc. 

2 View the data in Topo Plot view, in overlaid segment mode, and in Segment 
Time (by choosing View > as Topo Plot, View > as Overlaid Segments, and 
Time > Segment Time). 

3 Choose Time > Fit Segment To Window (see Figure 17-1 in Chapter 17, 
"Visualizing ERPs”). 

Notice that the P300 can be seen clearly at the centroparietal sites (the channels near 
the vertex) for the target condition. The P300 peaks approximately 370 ms after the 
onset of the auditory signal. Also note that at approximately 135 ms after the target, 
there is a negative deflection over the same sites. This is the N100. 

4 Switch to Chart view by choosing View > as Chart.

5 Choose Time > Actual Size (1:1).

6 In the Viewer, scroll down to channels 80 and 89, which are near the vertex. 

Next, you will drag the cursor to create a selection from 311 ms to 463 ms. To assist in 
making a precise selection, you can use tools on the status bar (see page 161 for an 
illustration of the status bar and a description of the tools). 

7 Set the sample/millisecond toggle to milliseconds mode, and the selection/
roll-over/Time Synch toggle to roll-over mode. 
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8 Using channel 89 to aid your selection, roll the cursor over the status bar until 
the timepoint indicator displays 311 ms (Figure 18-1). 

9 Drag the selection until the timepoint indicator shows that your selection spans 
from 311 ms to 463 ms. 

After you have made your selection, you can verify that it is correct by changing the 
selection/roll-over toggle to selection mode. That status bar should resemble the bar 
in Figure 18-2. 

10 Switch back to Topo Plot view (View > as Topo Plot), and choose Time > Fit 
Segment To Window.

You can now see your selection in all channels. The selection covers the time period in 
which the P300 is maximally different between the two conditions. Note this time 
window so that you can use it later to define the P300 for the individual subjects.

11 Repeat Steps 4–6 on page 166.

12 Using channel 89 to aid your selection, drag the cursor to create a selection from 
99 ms to 203 ms.

13 Switch back to Topo Plot view (View > as Topo Plot), and choose Time > Fit 
Segment To Window.

You can see your selection in all channels. The selection covers the time period in 
which the N100 is maximal for both conditions. Note this time window so that you 
can use it later to define the N100 for the individual subjects.

14 Close the file.

Figure 18-1. Timepoint indicator of the status bar in milliseconds mode

Figure 18-2. Status bar in selection mode
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Create a User Event Track

After selecting the ERP windows from the grand-average file, the next step is to use 
this information to define the ERP windows for individual subjects. You will use the 
baseline-corrected, multisubject-average file ATD256.av.bc. The first step is to create 
an event track for user events that span the selected time windows.

1 Open the file ATD256.av.bc. 

2 If necessary, select the Events control-strip disclosure toggle to display the 
Events control strip. 

3 Click the Insert Event Track button (Figure 18-3).

4 Name the track “Windows” and click New. 

Create a User Event Set and 
User Events

You will now create user events for defining ERP windows for statistic extraction.

1 Choose Events > Define User Events/Sets. 

The Define User Events and Event Sets dialog appears. 

Figure 18-3. Event control strip details

Insert Event Track button Select Event Sets pop-up menu 
(referred to in Step 3 on page 170)



Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

18: Extracting Data for Statistical Analysis

169

First, create an event set.

2 Click the Add button of the User Event Sets panel and name the new set “ERP 
Events”. 

There are 10 slots for every event set that you create. Now, define the events. 

3 Click the Add button of the User Event List panel and name the new event 
“N100”. 

4 Click the color bar next to the N100 event and define a new color. 

5 Repeat Steps 3 and 4 to create a “P300” event. 

Figure 18-4. The Define User Events and Event Sets dialog

Click to create 
an event set

Each event set 
has 10 slots, 
which you 
populate by 
dragging the 
events from the 
User Event List
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6 Drag the N100 and P300 events (one at a time) into the numbered slots above 
the User Event List panel (Figure 18-4). 

7 Click the Save button of the Define User Events and Event Sets dialog, saving 
your events and closing the dialog.

Insert User Events that Span the 
Selected Time Windows

You are ready to define ERP windows for statistics extraction using the user track and 
user events from the previous sections in this chapter.

1 Set up the Viewer by choosing the following: 

° View > as Chart 
° View > as Continuous Data
° Time > Actual Size (1:1)

2 If necessary, click the Windows event tile to select that track; the tile should 
change color and display a red arrow pointing at the track (Figure 18-5).

3 Select ERP Events from the Select Event Sets pop-up menu (refer back to
Figure 18-3). 

The Insert Event buttons above the event tracks now contain the N100 and P300 user 
events that you created. 

4 In the first segment, drag the cursor to create a selection from 99 ms to 203 ms, 
using the technique you learned earlier in this chapter. 

Note: You can actually do this in any segment because this time window will be applied to 
all segments in the next step. 

Figure 18-5. Select the Windows event track
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5 Option-click on the N100 Insert Event button.

The Event Placement dialog appears (Figure 18-6). This dialog offers you the choice of 
placing the event in other segments (in this case, subjects) and categories. Note that 
the temporal location of the event is specified by the selection.

6 Click “all Segments in all Categories” and click Apply. 

After a brief period, N100 events appear at the specified time in all segments. Now, 
insert an event for the P300.

7 Repeat Steps 4–6 for the P300 event, using the 311–463 ms time window and the 
P300 Insert Event button. 

Your event track should now resemble Figure 18-7. 

Figure 18-6. Event Placement dialog

Figure 18-7. Event track with N100 and P300 time-window events

Subj01 
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Correct

Subj01 
Target 
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Create a Montage to Verify the Time 
Windows for the Individual Subjects

It is known that the N100 and P300 have centroparietal distributions. Therefore, you 
will want to inspect the accuracy of the defined window by looking at the channels 
over these sites. Create a montage for this purpose.

1 Choose Montage > New Montage.

2 Name the new montage “Centroparietal” and click New.

3 In the Sensor Layout area of the Montage editor, select channels VREF, 9, 187, 
133, 80, 44, 43, 52, 79, 89, 132, 145, and 186. See Figure 18-8. 

4 Close the window, saving the montage.

Figure 18-8. Montage editor with Centroparietal channel group
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Verify the Time Windows for the 
Individual Subjects

Recall that you selected the windows from the grand-average file and applied the 
selections to the individual subjects. You will find that when you inspect individual 
subject data, they will often look substantially different from the grand-average data. 
Because of this, you will have to verify that the defined N100 and P300 windows for 
all subjects and categories are accurate.

Standard Correct Category
1 Choose View > as Overlaid Segments. 

2 From the Montage pop-up menu above the data-display area, choose 
Centroparietal. 

3 Option-click on the N100 event in the Windows event track.

This action selects N100 events for all categories and subjects (that is, segments). The 
duration of the event in the waveforms is highlighted with the color you defined for 
the N100 event. 

Figure 18-9. Montage pop-up menu in the data-display control strip
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4 Inspect the N100 window for all subjects. Use the Segment pop-up menu of the 
Overlaid Segments palette to change subjects (Figure 18-10). When changing to 
a new subject, do not forget to change to the new subject in both conditions. 

Notice that this event accurately describes the N100 window for all subjects.

Verify the P300 event definition. 

5 Option-click on the P300 event in the Windows event track.

6 Inspect the P300 window for all subjects. When changing to a new subject, do 
not forget to change to the new subject in both conditions. 

Notice that the P300 event accurately describes the P300 window for all subjects 
except subj03. For this subject, the P300 appears 50 ms earlier. Change the definition of 
the P300 for this subject to take into account the latency difference. You must do this 
for each category.

7 The events-display button for the Standard Correct category should be filled. If 
the button is empty, click on it so it is now filled (see Figure 18-10). 

8 Select Average: subj03 from the Segment pop-up menus for both the Standard 
Correct and the Target Correct categories.

In Overlaid Segments mode (as in all category-viewing modes), you can view the 
events for only one segment at a time. You will use the Events-display button to select 
the segment. 

9 Click anywhere in the Windows event track to deselect the P300 event.

10 Double-click on the P300 event.

Figure 18-10. Overlaid Segments palette

Filled events-display 
button

Empty events-display 
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Category pop-up menu
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Category pop-up menu

Segment pop-up menu
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An Event editor for that event appears, showing the onset time as 2.812 (Figure 18-11). 
Note that the Event editor always shows onset times in Relative Time mode.

11 Change the value in the Onset box to 2.762 and click OK. 

Target Correct Category
Repeat for the Target Correct category. 

1 Click the empty events-display button for the Target Correct category so that it 
is now filled (see Figure 18-10). 

2 Double-click on the P300 event.

3 Change the value in the Onset box from 3.412 to 3.362 and click OK. 

4 Verify that you have moved the P300 events only for subj03 by Option-clicking 
on the P300 event and scrolling through the subjects. 

5 Close the file.

Figure 18-11. Event editor for P300 event
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Create a Statistic Extraction 
Specification

Now that you have specified the time windows and channel group, you will use them 
to extract the relevant statistic. You will first need to create a Statistic Extraction 
specification.

A single Statistic Extraction specification can contain the specifications for one or 
more statistical analysis. For each input file, the Statistic Extraction tool outputs a tab-
delimited text file containing the number of statistical analyses created in the Statistic 
Extraction specification. In this case, you will create a Statistic Extraction specification 
with two analyses: one for the N100, and one for the P300. 

For each analysis, you need to specify the following parameters:

• a time window
• a statistical measure (one of mean amplitude, adaptive mean, minimum 

amplitude, maximum amplitude, and latency)
• how the measure is to be reported for each channel group
• one or more categories
• one or more channel groups

In this case, you will choose adaptive mean as the statistical measure. This algorithm 
first finds a peak within the time window. Then, a new time window is defined 
around this peak. The mean voltage value is calculated from the new time window. 
The measure will be reported as the average of the channels in the channel group. 

Editing the Specification
1 Open the Waveform Tools window.

2 Open a Statistic Extraction specification editor and name the Statistic Extraction 
specification “N100/P300 SE”.
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3 In the Output Options panel, set the name field to Append “.txt” (for text) and 
the destination field to Same As Source (Figure 18-12).

Setting the Tool-specific Parameters
Now, set the tool-specific parameters. First, make the events and categories from the 
data file available to the specification editor. 

1 Above the Available Categories and Available Events panes, click Clear List.

2 Above the Available Categories and Available Events panes, click the Select 
button, choose Other from the pop-up menu, navigate to and select the 
ATD256.av.bc file, and click Open.

You should now see the Standard Correct and Target Correct conditions in the 
Available Categories pane and the N100, P300, ast_, atg_, and resp events in the 

Figure 18-12. Statistic Extraction specification editor
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Available Events pane. The N100 and P300 events are those that you have defined 
(Figure 18-13). 

Creating Montages
The next step is to create montages that represent the channel groups to be used to 
extract the measure.

1 In the Montage pane, choose Geodesic Sensor Net 256 2.1 from the Sensor 
Layout pop-up menu.

2 Click the Add button to open the New Montage dialog, name the montage 
“Left Centroparietal,” and click the New button to close the dialog and view 
the Montage editor.

Figure 18-13. Available categories and events

Figure 18-14. Montage pop-up menu and display

Sensor Layout 
pop-up menu

Click to create 
a new montage
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3 In the Sensor Layout area of the Montage editor, select channels 9, 43, 44, 52, 
and 79 (Figure 18-15). 

4 Close the Montage editor, saving the changes.

5 Repeat steps 2–4, but name the new montage “Right Centroparietal” and select 
channels 132, 133, 145, 186, and 187.

Specifying the N100 Analysis
The Statistic Extraction specification editor has three panes for three different kinds of 
data: waveform, wavelet, and source. Click the Waveform Data tab to view that pane. 
In the Waveform Data pane, specify the analysis for the N100, working in the Statistic 
Extraction Settings pane, from the top to the bottom.

Figure 18-15. Creating the Left Centroparietal montage in the Montage editor
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1 Choose Adaptive Mean from the Measure pop-up menu (Figure 18-16).

2 Drag the N100 event from the Available Events pane to the “Measure for 
regions marked with event” box (see Figure 18-16). (Leave the extending region 
parameters at zero because you have already specified fully the window width 
with the N100 event.) 

3 Select Average of Channels from the Report pop-up menu

4 From the “Report the mean centered around the ___ peak” pop-up menu, 
choose “negative”.

5 Click the “of ___ samples in either direction” button and type “5” into the box.

6 Make sure the “Constrain window to inside the event region” checkbox is 
unselected.

7 Drag the Standard Correct and Target Correct conditions from the Available 
Categories pane to the Categories pane.

Figure 18-16. Statistic Extraction Settings pane

Measure 
pop-up 
menu

Drag 
events 
here
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8 Drag the Left Centroparietal and Right Centroparietal montages from the 
Montage pane to the Channel Groups pane (Figure 18-17).

With this specification, the algorithm will first find the negative peak within the N100 
window and then define a new window 11 samples wide (that is, 44 ms wide, with 
five samples on each side of the peak plus the peak sample). The average voltage 
value will be calculated for this new window. Note the “Constrain window to inside 
the event region” checkbox. If this box is checked, the new window will never go 
beyond the window specified by the N100 event. 

Specifying the P300 Analysis
You have completely specified the analysis for the N100 (Figure 18-17). Next, specify 
the analysis for the P300. 

1 Click the Clone button at the lower left of the editor to add another Analysis 
specification (see Figure 18-17).

Figure 18-17. Statistic Extraction Settings pane with the N100 window defined

Duplicates the 
selected analysis
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A new Analysis specification appears below the one for the N100, a copy. In the new 
Analysis specification:

2 Drag the P300 event from the Available Events panel to the “Measure for 
regions marked with event” box.

3 From the “Report the mean centered around the ___ peak” pop-up menu, 
choose “positive”.

The final Statistic Extraction specification should resemble Figure 18-18. 

4 Close the Statistic Extraction specification editor, saving the changes.

Figure 18-18. A completed Statistic Extraction specification
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Run the Statistic Extraction Tool

 

In this section, you will run the Statistic Extraction tool.

 

1

 

In the Waveform Tools window, add the ATD256.av.bc file to the Inputs pane. 
There are several ways to add a file to the pane; if necessary, see “Run the 
Segmentation Tool” on page 88 for a description of each method. 

 

2

 

Highlight the N100/P300 SE specification in the Specifications pane of the 
Waveform Tools window, and click the Run button.

 

View the Results

 

You now have a text file with the name ATD256.ave.bc.txt. This file opens with any 
text editor. Microsoft Excel is recommended. Figure 18-19 shows the results. 

 

Figure 18-19. 

 

Results of the Statistic Extraction operation
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The first row contains the name of the data file upon which the specification operated, 
and the second row displays the date and time the text file was created. These rows 
are followed by the two analyses. For each analysis, the first two rows display the 
event (N100 or P300) and a description, and the following row provides information 
about the measure. The remaining rows contain information about the categories and 
channel groups. 

Note that the actual data are formatted such that categories are indexed first 
(changing slowest), and channels are indexed second (changing the fastest). This is 
always true for the Statistic Extraction outputs. 

Exported in this way, the data are ready to be imported, with only the removal of the 
rows containing the header information (rows 1–9 for the N100), into a statistic 
program in a within-subjects (that is, repeated measures) format. In this example, the 
analysis model would be a 2 (target and standard) X 2 (left and right) Analysis of 
Variance model with both factors being within-subjects factors. 

After examining the results, close the text file.
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chapter 19

CHAPTER 19CREATING 
DIFFERENCE WAVES

common technique in psychological research is the subtractive method. The 
basic assumption is as follows:

If two experimental conditions differ in only one psychological process and the difference 
between these two conditions is taken, then common processes will be eliminated and the 
unique process will be preserved. 

Neuroimaging researchers use the subtractive method to reveal the brain area(s) 
involved in an isolated psychological process. However, designing experimental 
conditions that differ in only one process is not always easy.

You should invariably inspect the original waveforms to understand the difference 
waveform. The experimental conditions can differ in just one psychological process, 
and this difference may be associated with a unique ERP component(s). However, this 
psychological difference may also lead to latency differences in shared ERP 
components. The latency differences will distort the difference waves and may lead to 
spurious ERP components. 

In this chapter, you will learn how to create a file that contains the difference wave 
using the baseline-corrected, grand-average file ATD256.av.ga.bc.

A
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Create a Difference Wave Specification

Editing the Specification
1 If necessary, start Net Station and open the Waveform Tools window.

2 Open a Difference Wave specification editor and name the Difference Wave 
specification “ATD Dif”.

3 In the Output Options panel, set the name field to Append “.dif” (for 
difference) and the destination field to Same As Source.

Setting the Tool-specific Parameters
Now, set the tool-specific parameters.

1 From the Available Category pane, use the controls at the bottom of the 
pane (Select > Other) to select the file ATD256.av.ga.bc to view its categories.

Figure 19-1. Difference Wave specification editor
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In the Available Category pane, you will see the Standard Correct and Target Correct 
categories.

2 Drag the Target Correct category to the first empty cell of the Difference Wave 
Settings pane.

3 Drag the Standard Correct category to the second empty cell of the Difference 
Wave Settings pane.

4 Name the new category “Target–Standard” (Figure 19-1).

Notice the checkboxes beside the Target Correct and Standard Correct cells in the 
Difference Wave Settings pane. These boxes allow you to specify which event track to 
carry over into the new difference wave category. In this chapter, you will want to 
know the process that is unique to the Target Correct condition. 

5 Select the checkbox by the Target Correct cell.

This will take all the events in the event track of the Target Correct category and copy 
them over to the new Target–Standard category.

To examine the difference waveforms along with the original waveforms, you will 
want to include the original categories in the new file.

6 Click the Export All Categories radio button at the bottom of the pane.

Notice the Add and Remove buttons at the bottom of the pane. If the file 
ATD256.av.ga.bc had more categories, you would click the Add button to create 
additional difference wave settings. The Remove button deletes selected difference 
wave settings.

7 Close the Difference Wave specification, saving the changes.
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Run the Difference Wave Tool

In this section, you will run the Difference Wave tool.

1 In the Waveform Tools window, add the ATD256.av.ga.bc file to the Inputs 
pane. There are several ways to add a file to the pane; if necessary, see “Run the 
Segmentation Tool” on page 88 for a description of each method.

2 Highlight the ATD Dif specification in the Specifications pane of the Waveform 
Tools window, and click the Run button.

View the Results

1 After the process is complete, view the result file ATD256.av.ga.bc.dif in “as 
Overlaid Segments” mode. 

This mode allows you to examine the difference wave and determine the source of the 
difference.

2 Close the file.
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chapter 20

CHAPTER 20GENERATING 2D 
AND 3D ANIMATIONS

n this chapter, you will learn how to create two- and three-dimensional animations 
of the interpolated voltage data. These animations will allow you to view the 

spatiotemporal information inherent in EEG data. You will then learn how to make 
QuickTime movies for presentations and preparation of manuscripts.

It is assumed that you have completed the exercises in Chapter 17, "Visualizing ERPs,” 
which introduced the functions of the interpolated Topo Map view that are required to 
generate 2D animations and the texture maps used for 3D animations. If terms or 
functions associated with Topo Map view in this chapter are unfamiliar, you may 
want to refer back to Chapter 17. 

You can generate 2D animations entirely within Net Station. Creating 3D animations, 
however, is a two-part process: first, you generate texture maps in Net Station, and 
second, you model the texture maps on realistic head models and animate the results 
using Cinema 4D. This chapter is structured accordingly, with the following sections:

• common steps in creating 2D and 3D animations
• generating a 2D animation
• creating texture maps for 3D animations
• generating 3D animations

I
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Common Steps in Creating 
2D and 3D Animations

This section teaches you how to set the basic parameters for the 2D animations and 3D 
texture maps. Changing the parameters in Steps 6–10 allows you to alter the color 
spectrum and scaling of the 2D animations and 3D texture maps. To change the size of 
the resulting 2D animated maps, simply change the size of the Viewer window.

1 Open the baseline-corrected, grand-average file ATD256.av.ga.bc.

2 Choose View > as Chart and View > as Overlaid Segments (Figure 20-1). 

3 Choose Time > Segment Time.

4 In the data-display area, create a selection by dragging from –1 ms to 399 ms.

Figure 20-1. Choose to view as Chart and “as overlaid segments” 
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5 Choose View > as Topo Map (Figure 20-2).

6 In the Amplitude Scale palette to the left of the window, choose Seismic from 
the Spectrum pop-up menu (Figure 20-3).

Figure 20-2. Make a selection and choose to view as Topo Map

Figure 20-3. Set up the Amplitude Scale palette

Spectrum pop-up 
menu

Sub-epoch 
pop-up menu
Statistics-bar 
toggle

Lock toggle

Yellow area
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7 In the Amplitude Scale palette, choose the segment icon from the sub-epoch 
pop-up menu to base the histogram on the segment.

8 In the Amplitude Scale palette, select the Lock toggle, which makes the 
histogram expand to fill the area. 

9 In the Amplitude Scale palette, select the statistics-bar toggle to display the 
statistics bar.

10 In the Amplitude Scale palette, click in the yellow area of the statistics bar, 
which restricts the display of microvolts to within 2 standard deviations.

Generating a 2D Animation

Generating a 2D animation is straightforward, involving a simple file export to the 
2D QuickTime Movie format.

1 Choose File > Export.

2 In the Export dialog, choose 2D 
QuickTime Movie from the Format 
pop-up menu and choose the tutorial 
file folder as the destination.

3 In the Export dialog, name the file 
“ATD256.av.ga.bc.mov”.

4 In the Export dialog, click the Save 
button (Figure 20-4).

Viewing the 2D Animation
Net Station will generate a QuickTime movie of the time interval between 0 ms and 
400 ms. 

1 Double-click on the file ATD256.av.ga.bc.mov.

Figure 20-4. Export dialog
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The file will automatically open using QuickTime, allowing you to view the movie 
(Figure 20-5).

Creating Texture Maps for 
3D Animation

This section teaches you how to create a 3D texture map for wrapping onto a head 
model in Cinema 4D and converting to a QuickTime movie. In this section, you 
change the view from “as overlaid segments” to categories. Only one map is needed 
for wrapping on the head model.

1 If necessary, open the file ATD256.av.ga.bc.

2 Choose View > as Chart, and View > as Categories. 

3 Select the Standard Correct category.

4 Follow Steps 3–10, starting on page 190 from the “Common Steps in Creating 
2D and 3D Animations” section.

5 Choose File > Export, to open the Export dialog (see Figure 20-4).

Figure 20-5. View the movie in QuickTime
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6 Choose 3D Texture QuickTime Movie from the Format pop-up menu of the 
Export dialog.

7 Name the file “ATD256_STDCOR.mov” and choose the tutorial file folder as the 
destination.

8 Click the Save button.

If you wish to generate a QuickTime texture map for the Target Correct condition, 
repeat Steps 3–8, but instead of choosing the Standard Correct category, choose the 
Target Correct category.

9 Close the file.

Generating 3D Animations

For 3D head visualization, EGI recommends the Cinema 4D (version 10) product, 
available in both consumer grade and professional grade. The Cinema 4D programs 
are optimized for AltiVec and for multiple G4 processors, and can be run with 
rendering tasks distributed across multiple networked CPUs for maximum speed. 
The commercial Cinema 4D applications are available from EGI or directly from the 
publisher’s website at http://www.maxon.net. Cinema 4D head models are available 
from EGI. 

The head model and movie file used in this chapter reside on the Net Station 
installation disk. They are saved in the ERP Analysis Tutorial folder, in a folder called 
Cinema 4D Head Models (Figure 20-6). Make sure a copy of the Cinema 4D Head 
Models folder is on your desktop before proceeding.

Figure 20-6. Files for creating a 3D head animation

Files used in 
this chapter
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In this part of the tutorial, you will determine the length of your 3D texture map and 
use that information to create a movie of your 3D head model.

1 In the Cinema 4D Head Models folder, make sure that the file “alignment 
(256).mov” is in the same location as the head model Male 1 (256).c4d. 

2 Double-click on the head model Male 1 (256).c4d to launch Cinema 4D and to 
open the Male 1 (256).c4d file. 

3 Double-click on the Texture button at the bottom left of the Male 1 (256).c4d 
window, to open the Material Editor window (Figure 20-7). The Material Editor 
window displays the attributes of the preloaded movie named alignment 
(256).mov; the movie’s file name is displayed in the current-file button.

Figure 20-7. Open the Material Editor window

The current-file 
button displays the 
filename of the 
preloaded alignment 
movie

In the Male 1 (256).c4d 
window, double-click on 
the Texture button . . .

. . . to open the Material 
Editor window.
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4 In the Material Editor window, click the file-navigation button (the “. . .” 
button; see Figure 20-8) to open a file-navigation window. 

5 In the file-navigation window, navigate to and select the file named 
ATD256_STDCOR.mov, and click Open. If a dialog appears, stating that “this 
image is not in the document search path. . . .,” click the Yes button. Notice that 

Figure 20-8. Click the file-navigation button

File-navigation buttonCurrent-file button
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the ATD256_STDCOR.mov file name is now displayed in the current-file 
button (Figure 20-9).

6 Click the current-file button to display the Shader pane for the file 
ATD256_STDCOR.mov (Figure 20-10a).

7 Click the Animation button at the top of the Shader pane, to display the 
Animation pane (Figure 20-10b).

Figure 20-9. Replace the alignment movie with the 3D texture movie

Current-file button 
displays the name of 
ATD256_STDCOR.mov
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8 In the Animation pane, click the Calculate button (at the bottom) to view the 
animation parameters of the ATD256_STDCOR.mov (Figure 20-10c).

9 Remember the value in the Movie End Frame box. This is the length of your 
movie, in frames (which is 99 for this example). 

10 Close the Material Editor window.

Figure 20-10. Material Editor window, with its animation controls

Shader 
pane

Animation 
pane

Movie 
length

(a) Click the current-file button to open the Shader pane for the movie file ATD256_STDCOR.mov.

(b) Click the Animation button at the top to view the 
Animation pane. 

(c) Click the Calculate button at the bottom to view the 
length of the movie. 
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11 In the Male 1 (256).c4d window, choose Edit > Project Settings (Figure 20-11) to 
open the Project Settings window.

12 Enter the length of your movie in the Maximum box of the Project Settings and 
close the window.

Figure 20-11. Enter length of movie in the Maximum box of the Project Settings window

Type in the maximum 
frame length
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13 In the Male 1 (256).c4d window, choose Render > Render to Picture Viewer 
(Figure 20-12).

Figure 20-12. Choose Render to Picture Viewer from the Render menu
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Your animation will begin rendering, frame by frame (Figure 20-13). The resulting 
movie will be named “head animation.mov” and will be located in the same folder as 
the head model. Double-click on the movie to play it.

Figure 20-13. Head animation movie being rendered in Cinema 4D



Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

20: Generating 2D and 3D Animations

202



203Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 •  December 21, 2006

appendix A

APPENDIX ASOFTWARE 
TECHNICAL SUPPORT

Before Contacting EGI

Please check the Contents on page v and 
the Index on page 229 for coverage of 
your issue or question. You can also 
perform an electronic search using Find 
or Search in the PDF version of this 
manual posted on the Documents page 
of the EGI website (www.egi.com/
documentation.html).

In addition, the Support page of the EGI 
website (www.egi.com/support.html) 
may have the information you need.

If you need more help, EGI recommends 
the following:

• Try to isolate the problem. Is your 
problem well defined and repeatable? 

• Document the problem. Carefully 
record and organize the details gleaned 
from the above step and report the 
problem to EGI. 

Contacting EGI

EGI Support
web page

www.egi.com/
support.html

Email support support@egi.com

Sales 
information

info@egi.com

Telephone +541-687-7962

Fax +541-687-7963

Address Electrical Geodesics, Inc.

1600 Millrace Drive

Suite 307

Eugene, OR 97403

USA

http://www.egi.com/documentation.html
http://www.egi.com/documentation.html
http:///www.egi.com/support.html
http:///www.egi.com/support.html
http://www.egi.com/support.html
http://www.egi.com/documentation.html
http://www.egi.com/documentation.html
http://www.egi.com/support.html
http://www.egi.com/support.html
mailto:support@egi.com
mailto:info@egi.com
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appendix B

APPENDIX BUPDATING 
EGI LICENSES

EGI protects its software from unauthorized use by encoding licensing data in HASP 
keys. If you have purchased a complete EGI Geodesic EEG System, the HASP key is 
attached to the system cart handle. If you have purchased only the Net Station 
software, the key is included in the software installation package.

A HASP key is a small hardware device (sometimes called a dongle) that you plug into 
a computer’s USB port. The information in the HASP key tells Net Station whether 
you are allowed to use the software. 

All authorized Net Station users have a HASP key. To update your EGI license, do not 
send EGI the actual hardware key. Instead, you will need to generate a computer file 
from the HASP key and email the file to EGI, which will update the licensing 
information in the file and email it back to you. Use the edited HASP file to update 
your software. (See Figure B-1.)

Figure B-2 lists some points to keep in mind before you begin the HASP key–updating 
process. Step-by-step instructions for updating EGI licenses follow the tips. 

Figure B-1. Overview of the license-updating process

HASP key

1
Generate an 

Update file from 
your HASP key.

2
Compress the file 

and email it 
to EGI.

3
EGI will update 

the file and email 
it to you.

4
Uncompress the 
Updated file and 
use it to update 
your HASP key.

Success!
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Figure B-2. HASP-updating tips

File compression. Before emailing 
your Update file to EGI, compress the 
file (by Control-clicking on the file and 
choosing “Create Archive of 
<filename>” from the pop-up menu) 
to safeguard against file corruption 
during the email process. 

Unique HASPs. Updated HASP files 
are unique to their individual HASP 
keys. The HASP key that created the 
Update file must be plugged in when 
the Updated file from EGI is applied to 
update the license. Note: You may 
have multiple HASP keys with the 
same name, followed by a number. 
The number of the HASP key must 
match the number of the Update file 
when updating.

HASP names. To determine which 
HASP key is which, launch Net Station. 
The name of the HASP key is in the 
bottom-left of the Net Station start-up 
screen. Quit Net Station, launch the 
Updater application, and apply the 
corresponding HASP file.

File organization. Avoid duplicate 
Update files. After emailing your 
Update file to EGI, delete it from your 
computer. Likewise, after applying the 
Updated file from EGI to your HASP 
key, delete the file.

Tips on Updating EGI Licenses
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Figure B-3. Open the HASP Updater application

Opening the Updater Application
1   Quit Net Station, if necessary.

2   Insert the HASP key into the USB port at the side of your keyboard or at the back 
of your computer. A light should illuminate within the key.

3   On your hard drive, 
open the Applications 
folder.

4   Open the Net Station install 
folder in the Applications folder.

5   Open the Extras folder and 
double-click on the NS 
Remote HASP Updater icon to 
launch the application and 
open the Updater dialog.
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Figure B-4. Create the HASP Update file, compress it, and email it to EGI

Generating the Update File
1   Make sure that the 
Create Update File tab is 
frontmost in the Updater 
dialog.

2   Click the HASP 
file button.

3   The Update dialog will automatically close, and an Update 
file will appear on your Desktop with the filename “NS – 
xxxx,” where xxxx is the license holder’s name. If you have 
more than one HASP, the number of the HASP will be 
appended (e.g., NS - Ling Chan, NS - Ling Chan 1).

4   Compress the file by Control-clicking on the file 
and choosing Create Archive of “<filename>” from 
the pop-up menu. This will ensure that your file is not 
corrupted in transit. Note that this operation must 
be performed on a Macintosh computer, not a PC.

5   Email the compressed file to 
support@egi.com and include in the email 
message your name, the license holder’s 
name (if you are not 
the licensee), your 
organization, and a 
description of what 
must be updated. 
For best results, email 
the file from the Macintosh computer that 
generated it. Or, you can copy the file to a 
Mac HFS-formatted removable drive, 
transfer it to another Mac, and email it. Do 
not email it from a PC.

6  Delete the HASP 
Update file and any 
previous compressed 
copies from your 
Desktop.

7  EGI will modify the file, updating 
your license, and email it back to you, 
typically within two to three days.
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Figure B-5. Apply the Updated file from EGI to the corresponding HASP

Applying an Updated File
1   Save to the Desktop the Updated file from EGI, uncompressing it if needed.

2   Quit Net Station, if necessary.

3   Insert the corresponding HASP key into the USB port at the side of your 
keyboard or at the back of your computer. A light should illuminate within the key.

4   Open the Net Station install folder in the Applications folder on your hard drive.

5   Double-click on the NS Remote HASP Updater icon, which will open the 
Updater dialog.

6   Make sure that the 
Update HASP tab is 
frontmost in the Updater 
dialog. 

7   Drag the Updated file 
into the Update box.

8   A dialog will appear, with 
a message indicating a 
successful update.

9   Delete the Updated 
file and any compressed 
copies from your 
Desktop.
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Questions

Contact EGI at support@egi.com with any questions regarding this document and the 
issues discussed.

mailto:support@egi.com
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appendix C

APPENDIX CHOW TO EXPORT 
FILES FOR GRAPHICS

This appendix provides a brief set of instructions on how to generate publication-
quality graphics for ERP (EEG) waveforms. The appendix assumes that you are 
familiar with vector-based graphics program such as Adobe Illustrator or Deneba 
Canvas. We recommend that you use a vector-based graphics program rather than a 
raster-based (i.e., bitmap) program such as Adobe Photoshop because you can resize 
vector-based graphics without diminishing the resolution or creating “jaggies.” 

Two operations are covered: exporting ERP (EEG) waveforms and exporting 
topographic maps. The first process applies to EEG data viewed in Chart or Topo Plot 
mode, and the second relates to data in Topo Map View mode. Of the five views 
offered by Net Station, printing is enabled for only these three modes because the 
other two—Grid View and Synoptic Plot View—are designed to allow onscreen 
identification of bad channels, and spatial and temporal patterns, respectively.

You must have a PostScript-compatible printer to print Chart and Topo Plot Views; 
however, the printer driver cannot tell if a chart or plot is in grayscale or color, so it 
prints them only in grayscale. You can change them to color after exporting to a 
graphics program. Topo Map View, on the other hand, can print to a non-PostScript 
printer and can print in color.

Note: The graphics output is WYSIWYG (What You See Is What You Get), so you must 
ensure that the view (either in Chart or Topo Plot) is exactly as you would like it to appear.

Note: Adobe Illustrator has difficulty properly orienting channel labels when it opens a 
Topo Plot PostScript file. Because Adobe Distiller does not have this problem, we 
recommend the following workaround: (1) Choose Print > Set to Print Size > Page Setup 
and choose Landscape orientation. (2) In the Print window, choose File in the Destination 
pop-up menu. (3) Run the PostScript file through Adobe Distiller, open the resulting PDF 
in Illustrator, and save in the appropriate graphics format. 

For additional information about the concepts discussed, see Chapter 10, “Topo Map 
View”; Chapter 14, “Amplitude-Scale Palette”; Chapter 16, “Printing”; and Chapter 
19, “Montages,” in the Net Station Viewer Technical Manual.
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ERP (EEG) Waveforms

1 Select the relevant experimental conditions.

2 In either Chart or Topo Plot View, select the channel(s) desired for illustrating 
the waveform. Do this by using the Montage Controls window to create a 
montage with just those channels. (See “Montage Controls Window” in 
Chapter 15, “Montages,” in the Net Station Viewer Technical Manual.)

Choose Montage > Show Montage Controls Window

Click New to create a new montage with only the desired channels
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A blank montage template appears

Click on the desired sensors to add them to the new montage (see list of output channels 
at right). To deselect a sensor, click it again. When finished, click Save and Apply. 
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3 Set Time and Amplitude Scales to best illustrate the data. 

The Time menu

The Amplitude menu
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Optional step: To include a scale ruler in your figures, click on the scale-ruler 
toggle to make the scale ruler appear. Adjust the amplitude and time scale of the 
scale ruler to the desired settings, and drag it next to a waveform channel.

Click on the scale-ruler toggle to make the scale ruler appear

A close-up view of the scale ruler, a draggable display of the amplitude and time scales

scale-ruler 
toggle
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4 Set Background Color (in Viewer Preferences) to white.

Choose Edit > Viewer Preferences

In the Viewer Preferences dialog, clicking on the color box next to the label 
“Background” opens the Colors window, which allows you to change the color
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5 Under the File menu, choose Print Window (for Chart View) or Print Topo Plot 
(for Topo Plot View). 

File > Print Window (in Chart View)

File > Print Topo Plot (in Topo Plot View)
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6 In the Print dialog that appears, (a) choose Save PDF as PostScript in the PDF 
pop-up menu, which opens the Save to File dialog. (See Chapter 11, “Printing,” 
in the Net Station Viewer Technical Manual for more information.)

7 In the Save to File dialog, name the output file and select the output destination.

8 Click Save. 
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Topo Maps

1 In Topo Map View, select your desired timepoint(s).

2 Set desired Layout.

3 Select desired color palette.

4 Set palette range.

(For more information about the Layout dialog, and the amplitude-scale palette 
and the Set Ranges dialog, see Chapter 10, “Topo Map View” and Chapter 14, 
“Amplitude-Scale Palette,” respectively, in the Net Station Viewer 
Technical Manual.)

Topo Map View

The controls for setting layout, 
color, and range
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(a) Click Layout to open the Map Layout and Size dialog, (b) choose a 
color from the spectrum pop-up menu, and (c) click the Set Ranges 

button to open the Set Ranges dialog

a

b

c



221Net Station Viewer and Waveform Tools Tutorial  S-MAN-200-TVWR-001 • December 21, 2006

C: How to Export Files for Graphics

Optional step: To include an amplitude scale in your figures, click on the 
amplitude-scale palette toggle to make the amplitude scale appear.

5 Under the File menu, choose Print Window. 

amplitude-
scale palette 
toggle

The amplitude-scale palette toggle can make the amplitude-scale palette appear 
(enlarged view of palette at left), which you can capture in an image

Choose File > Print Window
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6 In the Print dialog that appears, (a) choose Save PDF as PostScript in the PDF 
pop-up menu, which opens the Save to File dialog. (See Chapter 11, “Printing,” 
in the Net Station Viewer Technical Manual for more information.)

7 In the Save to File dialog, name the output file and select the output destination.

8 Click Save. 
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After the Export

You are now ready to open your file in either Illustrator or Canvas (or any other 
graphics program). Once you are in the graphics program, you may have to 
“ungroup” the object to edit individual components. You will then have the capability 
to arrange your data to meet your publication needs. (See “Exporting Texture Maps 
for 2D & 3D Animations” in Chapter 10 , “Topo Map View,” in the Net Station Viewer 
Technical Manual.)

Graphics Resources

This section introduces you to some common computer graphics resources and terms. 
It is by no means complete or authoritative. The companies and products in the 
following list were discovered through various web searches; EGI is neither 
responsible for nor does it endorse them.

Graphics Websites and Books
Some developers of vector graphics software:

• Adobe (products—Illustrator and Free Hand): www.adobe.com
• CambridgeSoft (product—ChemDraw): www.cambridgesoft.com
• Computer Systems Odessa (product—ConceptDraw): www.conceptdraw.com
• Corel (product—CorelDraw): www.corel.com
• Microsoft (product—Expression): www.microsoft.com
• Deneba (product—Canvas): www.deneba.com

Some graphic design resources:

• Computer Graphics—Principles and Practice, by J.D. Foley et. al, published by 
Addison-Wesley: www.aw-bc.com

• Displaying Your Findings—A Practical Guide for Creating Figures, Posters, and 
Presentations, by A.A.M Nicol and P.M. Pexman, published by the American 
Psychological Association: www.apa.org

• Grantastic Designs: www.grantasticdesigns.com

• Pantone: www.pantone.com

• The Dictionary of Computer Graphics and Virtual Reality, by R. Latham, 
published by Springer-Verlag: www.springer-ny.com
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Graphics Glossary
Sources: Grantastic Designs (www.grantasticdesigns.com), Edinburgh Online 
(www.dai.ed.ac.uk), and Hokum (http://hokum.freehomepage.com)

A
adaptive sampling   A method of reducing aliasing artifacts when rendering by 
adapting the sampling rate in response to the local characteristic of the object being 
rendered. This technique is often used to reduce the jagged edges of objects.

aliasing   In graphic design, aliasing occurs when a computer monitor, printer, or 
graphics file does not have a high enough resolution to represent a graphic image or 
text. An aliased image is often said to have the “jaggies.”

animation   Animation is the creating of a timed sequence or series of graphic images 
or frames together to give the appearance of continuous movement.

antialiasing   Antialiasing is the smoothing or blending of the transition of pixels in an 
image. Antialiasing the edges on a graphic image makes the edges appear smooth, not 
jagged.

B, C
bitmap   Strictly a one-bit-per-pixel representation for a defined area of a display.

bitmap image (bmp)   A graphic image stored as a specific arrangement of screen dots 
or pixels. Web graphics are bitmap images. Also known as raster graphics, common 
bitmap formats include GIF, JPEG, Photoshop, PCX, TIFF, Macintosh Paint, Microsoft 
Paint, PNG, FAX, and TGA.

CMYK   Stands for the colors cyan-magenta-yellow-black. In print design, colors are 
defined as a percentage of each of these four colors (e.g., the CMYK for black is 0-0-0-
100). In contrast, display devices (i.e., computer monitors) typically define colors 
using RGB.

compression   A method of packing data to save disk storage space or download time. 
JPEGS are generally compressed graphics files. Compression makes a file or data 
stream smaller. 
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D, E
dithered/dithering   To display a full-color graphic image on a 256-color monitor, 
computers must simulate the colors they cannot display. They do this by dithering, 
which is combining pixels from a 256-color palette into patterns that approximate 
other colors. At a distance, the human eye merges the pixels into a single color. Up 
close, the graphic image will appear pixelated and speckled.

dpi   Stands for dots per inch and specifies the resolution of an output device, such as 
a printer or printing press machine. Print resolution usually runs from 300 to 1,200 dpi 
on a laser printer, 125–255 dpi for photographic images on a print brochure, and 
72 dpi for web publishing. (For information about input device measurement, see 
ppi.)

export   To save a file in a different program (e.g., many Adobe Photoshop files are 
exported to become GIF or JPEG files).

F, G, H
font   A font is a complete set of characters in a particular size and style of type. This 
includes the letter set, the number set, and all of the special character and diacritical 
marks obtained by pressing the Shift, Option, or Command keys (e.g., Times 
NewRoman Bold is one font, Times NewRoman Italic is another font, and Times 
NewRoman is a single typeface).

frame   In animation, a frame is a single graphic image in a sequence of graphic 
images.

GIF   Stands for Graphics Interchange Format. GIF images are the most widely used 
graphic format on the web. GIF images display up to 256 colors.

grayscale   An application of black ink (for print) or the color black (for the screen) 
that simulates a range of tones. Grayscale images have no hue (color). In print design, 
a grayscale graphic image appears to be black, white, and shades of gray, but it only 
uses a single color ink.
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HSB   Stands for hue-saturation-brightness. HSB is based on three fundamental 
characteristics of color: hue is the color reflected from or transmitted through an object; 
saturation is the strength or purity of a color; and brightness is the relative lightness or 
darkness of the color.

hue   The actual color of an object. Hue is measured as a location on a color wheel, 
expressed in degrees. Hue is also understood as the names of specific colors, such as 
blue, red, and yellow.

I, J, L
interlace   Storing partial data from a single graphic image in multiple sequences. The 
purpose of interlacing is to have a partial image initially appear onscreen, rather than 
having to wait for the image to appear in its entirety. With interlacing, equally spaced 
sets of lines from the original image are stored together, and these sets appear one on 
top of the other in sequence.

JPEG   Abbreviation for Joint Photographic Experts Group. File format for full-color 
and black-and-white graphic images. JPEG images allow for more colors than GIF 
images and are usually smaller in size.

lossless compression   In graphic design, lossless compression refers to a data-
compression technique where the file quality is preserved and no data are lost. 
Lossless compression is commonly used on GIF images, but it can only reduce the file 
size to about half its original size. Lossy compression, on the other hand, eliminates 
data to further decrease the file size.

lossy compression   A term coined by graphics programmers to refer to a technique of 
shrinking file sizes by giving away some precision of detail. JPEG is an example of a 
file that is compressed this way. 

lpi   Stands for lines per inch. 

LZW   Stands for Lemple-Zif-Welch. LZW is a lossless compression technique 
supported by TIFF, PDF, GIF, and Postscript file formats. It is most useful in 
compressing images that contain large areas of single color, such as screenshots or 
simple paint images.
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M, O
moiré   A shimmering “interference” pattern produced when two geometrically 
regular patterns are superimposed.

opaque   Impervious to light. An opaque surface will reflect light to some degree 
dependent on surface attributes.

overlay   An image compositing method where an image is displayed over a 
background image.

P
pixel   Stands for picture element. A pixel is the smallest element that can be 
independently assigned color.

PNG   Stands for Portable Network Graphics format and is generally pronounced 
“ping.” PNG is used for lossless compression and for displaying images on the web. 
The advantages of PNG is that it supports images with millions of colors and 
produces background transparency without jagged edges. The disadvantages are that 
PNG images will not show up on older browsers and still can be larger in file size than 
GIFs.

ppi   Stands for pixels per inch and specifies the resolution of the input device, such as 
a scanner, digital camera, or monitor. Web page resolution ranges from 72 to 96 ppi. 
(For information about output device measurements, see dpi.)

R
raster graphic   See bitmap image (bmp).

rasterize   The process of converting a projected point, line, polygon, or the pixels of 
an image to fragments, each corresponding to a pixel in the framebuffer.

rendering   The process of creating an image from a description of a scene, its objects 
and light sources, and the viewer.

resolution   Indicates the number of pixels per image (see ppi). It is often represented 
as N x M, where N and M are the number of pixels per column and per row, 
respectively.
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RGB   Stands for the colors red-green-blue. In web design and computer monitors, 
colors are defined in terms of a combination of these three colors (e.g., the RGB for 
blue is 0-0-255). In contrast, print designers typically define colors using CMYK.

S
saturation   The color intensity of an image. An image high in saturation will appear 
to be very bright. An image low in saturation will appear to be duller and more 
neutral. An image without any saturation is also referred to as a grayscale image.

subtractive colors   Cyan (C), magenta (M), and yellow (Y). These colors combine to 
absorb all color and to produce a muddy brown color. Black (K) is added to produce 
pure black. Also known as CMYK.

T, V
texture map   A bitmap used to texture a 3D polygon model, including adjustments for 
perspective correction, where vertices of the object model are mapped onto the 2D 
texture bitmap.

transparency   The ratio of the amount of light passing through a material to the 
amount of light incident on the material.

true color system   A 24-plane graphics subsystem that produces the complete range 
of 16.7 million available colors.

vector graphic   A graphic image drawn in shapes and lines, called paths. This allows 
them to be resized without any loss of resolution. Images created in Illustrator or 
FreeHand are vector graphics. 

video   A series of framed images put together, one after another, to simulate motion 
and interactivity. A video can be transmitted by number of frames per second and/or 
the amount of time between switching frames. The difference between video and 
animation is that video is broken down into individual frames.
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A
Absolute Time    40

Amplitude Scale panel    39, 154

amplitude-scale range, optimal    155

animated scrolling buttons    157

artifact

definition of    45

Artifact Detection

log file    96

"Perform inferences" section    96

Threshold Artifact Detection Settings, 

description of    95

artifact detection    68, 95

additional correction techniques    107

ATD experiment    25

ATD II Script    143

ATD II Script specification    143

auditory oddball    25

auditory P300    25

auditory target detection experiment    25

Auto Set Name checkbox    74

Available Categories panel    177

Available Events panel    177

Average of Channels radio button    180

average referencing    69

averaging    69, 115

Averaging specification editor    116

B
bad channel

definition of    49

marking automatically    95

marking manually    92

toggles    51

bad channel replacement    68, 109

bad channel replacement algorithm    109

Bad Channel Replacement 

specification editor    110

baseline correction    69, 127

cannot undo    69

last step in ERP derivation    69

performed separately on individual-subject and 

grand averages    70

Baseline Correction specification editor    128

Browse Event Criteria window    83

Butterfly montage    129

C
category    29

Category pop-up menu    174

category selector    90

category, in experiments    81

CELL event    58

cell, in experiments    27

centroparietal    172
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Channel Groups panel    181

channel highlighting    47

Channel Size panel    111

channel tiles    47

channel toggles    50

Channel Zoom mode    151

channel-height buttons    129

Cinema 4D    194

Combine Files By pop-up menu    140

Combine Files specification editor    141

condition, in experiments    28, 81

“Constrain window to inside the event region” 

checkbox    180

Copy Events From First File button    142

Copy Specs To Segment    85

Count Segments for Which Channel is Bad    103

Criteria definition panel    85

Criteria for Event panel    82

criteria, in experiments    28, 81

D
Data display    38

data-analysis path    70,    131

exploring individual trials    69

exploring multisubject trials    69

issues with ERP derivation    69

Data-display control strip    38

Define User Events and Event Sets dialog    168

Difference Wave Settings panel    187

Difference Wave specification editor    186

E
ECI track    55

"entire current epoch" icon    155

Epoch Time    40

ERP    29, 67

comparing    149

ERP derivation

operations    68

overview    67

process    68

event

inserting into tracks    53

purpose of    55

event code    28, 57

Event editor window    62

event label    57

Event List window    55

event marker    28, 55, 57

Event Placement dialog    171

event-related potential    29, 67

Events control strip    38

Events-display button    174

Export All Categories radio button    187

eyeblink artifact

definition of    52

F
File Info dialog    103, 134

filter

finite impulse response (FIR)    49

flattening effect on data    80

infinite impulse response (IIR)    48

Filter Events window    60

Filter menu    49

Filter Settings panel    75

filtering    68, 73

Filtering specification editor    76

Filtering Specification Name text box    74

finite impulse response (FIR) filter    49

G
Grand Average specification editor    142

grand averaging    139

grand-average ERP    67
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graphics

exporting ERP (EEG) waveforms    212

exporting Net Station data for    211

exporting Topo Maps    219

glossary    224

Topo Plot View, label orientation    211

websites and books    223

WYSIWYG    211

Grid View    100

H
Handle Source Files panel    116, 141

Handle Subjects panel    116, 141

histogram    154

histogram maximum label    155

histogram minimum label    154

History pane    135

I
ideal zero reference value    121

infinite impulse response (IIR) filter    48

Insert Event buttons    170

Insert Event Track button    168

Interpolation Density panel    158

interpolation method    109

J
Jobs and Results window    78

K
Keep Output File checkboxes    143

Keep Output File option    132

key list    57

L
latency difference    174, 185

Layout dialog    157

Layout panel    111

Link button    38, 46

linking windows    46

List Bad Channels Per Segment    103

Lock toggle    155

Lowpass checkbox    75

Lowpass slider    75

M
Map Layout panel    158

Map Size panel    158

Measure pop-up menu    180

metadata    57

millisecond-mode icon    161

Minimize button    161

Mode pop-up menu    103

montage

Butterfly    129

creating to verify time windows    172

Eyes    52

Montage feature    52

Montage Operations specification editor    123

Montage Operations tools    122

Montage pop-up menu    52,    120

N
N100    25

navigation

through data    41, 42

Navigation control strip    38

navigation controls    39, 42

Navigation control-strip slider    39
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Net Station data files

opening    34

opening by double-clicking    35

opening by dragging files    35

opening with file-selection dialog    35

Net Station default state    34

Net Station Preferences folder    34

noise

definition of    45

line noise    46

recognizing in raw recording    45

O
“of ___ samples in either direction” button    180

Options panel    111

output options    70

Overlaid Segments palette    150, 174

Overlaid Segments viewing option    149

Overlay button    151

Overwrite All Previous Information 

checkboxes    98

P
P300    25

palette-maximum label    154

palette-maximum slider    154

palette-minimum label    154

palette-minimum slider    154

parameter, specifying    69

PARE (polar average reference effect)    121

PARE-corrected average reference    122

Perform PARE Correction checkbox    123

Plot Size panel    111

polar average reference effect (PARE)    121

Polarity panel    39

Preview Segmentation panel    86

printing

Chart and Topo Plot Views, grayscale    211

Topo Map View, color    211

using PostScript and non-PostScript 

printers    211

Project Settings window    199

Q
QuickTime movies

creating    189

R
reference channel    119

Relative Time    40

Render menu    200

“Report the mean centered around the ___ peak” 

pop-up men    180

rereferencing

purpose of    121

Restore button    161

roll-over–mode icon    161

S
sample/millisecond toggle    161

sample-mode icon    161

Scale control strip    37

screen aliasing    40

Script Settings panel    131

Script specification editor    133

scripting    71, 131

segment    29

Segment Length After box    86

Segment Length Before box    85

Segment pop-up menu    174

segment selector    90

Segment Status icon    91

Segment Status palette    91

Segment Time    40

segmentation    29, 68, 81
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Segmentation Settings    82

Segmentation specification

previewing of    86

Segmentation specification editor    82

Select Baseline From pop-up menu    128

Select Baseline With Respect To 

pop-up menu    128

Select Event Sets pop-up menu    170

selection

extended selection of continuous data    43

multiple files in file-selection dialog    78

selection cursor    43

selection/roll-over toggle    161

selection-mode icon    161

Sensor Layout area    172, 179

SESS event    57

single-subject average    67

spatiotemporal information    189

specification

for artifact detection    97

for averaging    115, 141

for bad channel replacement    109

for baseline correction    127

for combining files    140

for difference wave    186

for filtering    73

for montage operations    122

for scripting    131, 142

for segmentation    81

for statistical extraction    176

specification editor

Averaging    116

Bad Channel Replacement    110

Baseline Correction    128

Combine Files    141

Difference Wave    186

Filtering    76

Grand Average    142

Montage Operations    123

Script    133

Segmentation    82

Statistic Extraction    182

Spectrum pop-up menu    154

spherical splines    109

standards, in experiments    25

Statistic Extraction specification editor    182

Statistic Extraction tab-delimited file    183

Statistic Extraction tool    176

Statistic Extration tool    165

statistical extraction

selecting time windows for    166

statistical measure    176

statistics bar    155

statistics-bar toggle    155

status bar    38

Status button    91

sub-epoch pop-up menu    155

subtractive method    185

T
targets, in experiments    25

Texture tile    195

3D animation

generating    194

rendering of    201

texture maps for    193

3D Texture QuickTime Movie    194

Threshold Artifact Detection Settings

description of    95

Time control strip    38

time mode

Absolute Time    40

Epoch Time    40

Relative Time    40

Segment Time    40

setting of    40

time ruler    39

Time Synch    160

time windows

verifying    173

timeline    40

time-mode button    40

timepoint indicator    160
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tool specification editor    70

Topo Map View    152

amplitude scale, use with    152

Topo Plot View    111

track

ECI    55

Tracks control strip    38

trial specification    28

trial, in experiments    27, 58

distinguishing between standard and 

target    88

tutorial data files    33

tutorial tasks    26

2D and 3D animations, common steps    190

2D animation

generating    192

viewing    192

2D QuickTime Movie    192

U
user event

inserting to span time window    170

User Event List panel    169

User Event Sets panel    169

user event track

creating a    168

sample    171

user events

creating    168

V
Viewer window

main window of Net Station Viewer    33

viewing data

continuous EEG in Chart View    39

W
waveform shape, affect of averaging    118

Waveform Tools    70

Waveform Tools window    74
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